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Tentang Ubuntu

Ubuntu
Dari Wikipedia bahasa Indonesia, ensiklopedia bebas.

Ubuntu adalah salah satu distribusi Linux yang berbasiskan pada Debian. Proyek Ubuntu disponsori oleh 
Canonical  Ltd  (perusahaan  milik  Mark  Shuttleworth).  Nama  Ubuntu  diambil  dari  nama sebuah  konsep 
ideologi  di  Afrika Selatan.  "Ubuntu" berasal dari  bahasa kuno Afrika,  yang berarti  "rasa perikemanusian 
terhadap sesama manusia".  Ubuntu juga bisa berarti  "aku adalah aku karena keberadaan kita semua". 
Tujuan dari distribusi Linux Ubuntu adalah membawa semangat yang terkandung di dalam Ubuntu ke dalam 
dunia perangkat lunak. Ubuntu adalah sistem operasi lengkap berbasis Linux, tersedia secara bebas dan 
mempunyai dukungan baik yang berasal dari komunitas maupun tenaga ahli profesional. Komunitas Ubuntu 
dibentuk berdasarkan gagasan yang terdapat di dalam filosofi Ubuntu:

• bahwa perangkat lunak harus tersedia dengan bebas biaya

• bahwa aplikasi perangkat lunak tersebut harus dapat digunakan dalam bahasa lokal masing-masing 
dan untuk orang-orang yang mempunyai keterbatasan fisik, dan

• bahwa pengguna harus mempunyai kebebasan untuk mengubah perangkat lunak sesuai dengan apa 
yang mereka butuhkan.

Perihal  kebebasan inilah  yang  membuat  Ubuntu  berbeda dari  perangkat  lunak  berpemilik  (proprietary);  
bukan hanya peralatan yang Anda butuhkan tersedia secara bebas biaya, tetapi Anda juga mempunyai hak 
untuk memodifikasi perangkat lunak Anda sampai perangkat lunak tersebut bekerja sesuai dengan yang 
Anda inginkan.

Logo Ubuntu :

Rilis
Setiap rilis mempunyai nama kode dan nomor versi. Nomor versi berdasarkan tahun dan bulan dari rilis.  
Sebagai contoh, rilis Ubuntu yang pertama, 4.10, dirilis tanggal 20 Oktober 2004. Rilis ubuntu keluar setiap 6 
bulan sekali tiap bulan April dan Oktober.

Rilis  ubuntu  biasanya  terdiri  dari  2  edisi,  yaitu  edisi  Desktop  dan  Server.  Perbedaan  mendasar  pada 
keduanya adalah pada versi desktop terdapat tampilan desktop manager sedangkan pada edisi server tidak  
ada,  hanya  command prompt  saja.  Screenshot  Ubuntu  6.10  (Edgy  Eft)  dengan menggunakan  window 
manager Beryl

Daftar rilis Ubuntu yang telah dirilis dan yang direncanakan untuk dirilis:

Versi Tanggal Rilis Nama kode Sub Versi Didukung sampai 

4.10 20 Oktober 2004 Warty Warthog Sounder 30 April 2006 

5.04 8 April 2005 Hoary Hedgehog Array 31 Oktober 2006 

5.10 13 Oktober 2005 Breezy Badger Colony 13 April 2007 

6.06 LTS (Long 
Term Support) 

1 Juni 2006 Dapper Drake Flight Juni 2009 (desktop) 

Juni 2011 (server) 

6.10 26 Oktober 2006 Edgy Eft Knot April 2008 

7.04 19 April 2007 Feisty Fawn Herd Oktober 2008 

7.10 18 Oktober 2007 Gutsy Gibbon Tribe April 2009 

8.04 LTS (Long 21 April 2008 Hardy Heron Siege April 2011 (desktop) 



Term Support) 

April 2013 (server) 

8.10 30 Oktober 2008 Intrepid Ibex 

9.04 April 2009 Jaunty Jackalope 

Pengenalan

➔ Bagaimana cara mencari tahu versi Ubuntu yang anda gunakan
Pada command line terminal ketikkan : 

$ lsb_release -a

➔ Bagaimana cara mencari tahu versi dari kernel anda
Pada command line terminal ketikkan : 

$ uname -r

➔ Versi terbaru dari Ubuntu
1. Ubuntu memiliki siklus rilis enam bulan sekali, dengan rilis pada bulan April dan Oktober.

2. The penerus untuk  Ubuntu 8,10 adalah Intrepid Ibex Ubuntu 9,04 Jaunty Jackalope,  dijadwalkan 
untuk rilis pada bulan April 2009. Ini tidak akan menjadi versi LTS.

3. Berikutnya  LTS (Long-term support)  pada  versi  Ubuntu  9,10,  dijadwalkan  untuk  rilis  pada  bulan 
Oktober 2009.

➔ Versi Lama dari Ubuntu
1. Hardy Heron (LTS 8,04) (Dukungan Jangka Panjang versi desktop dengan dukungan sampai April 

2011 dan server mendukung sampai April 2013)

2. Gutsy Gibbon (7,10) (didukung sampai April 2009)

3. Feisty Fawn (7,04) (tidak didukung)

4. Dapper Drake (6.06 LTS) (Dukungan Jangka Panjang versi desktop dengan dukungan sampai Juni  
2009 dan server mendukung sampai Juni 2011)

Fitur Desktop pada Ubuntu 8.10 Intrepid Ibex
Intrepid Ibex –yang secara harfiah berarti "kambing gunung yang gagah berani", ini dapat menjadi pilihan  
anda sebagai sistem operasi yang dapat dioperasikan dengan mudah. Berikut ini akan dibahas beberapa 
Fitur Ubuntu Linux 8.10 Intrepid Ibex:

➔ GNOME 2.24
Desktop manager default ubuntu ini menawarkan kemudahan bagi pengguna, khususnya pengguna yang 
tidak ingin direpotkan dengan konfigurasi x-window. Beberapa fitur baru yang dsktop manager ini:



Aplikasi pelacakan waktu (time tracking)

Aplikasi  ini  memudahkan  anda  untuk  mengetahui  apa  saja  yang  sudah  anda  lakukan  selama 
menggunakan desktop ini, aktivitas copy, paste , browsing dan lain sebagainya akan tercatat secara 
otomatis didalam Deskbar Search yang biasa terletak pada panel desktop bagian atas, tampilan panel 
deskbar applet nya seperti pada gambar berikut ini

Dengan mengetikkan kata kunci pada field search, makan secara otomatis pada bagian bawah field 
akan menampilkan beberapa nama file dan kegiatan yang berkaitan, jika kita pilih dengan mengeklik 
pada list file, maka file yang bersangkutan akan diload/dibuka.

Ekiga, Audio/Visual Conferencing

Audio/Visual Conferencing berbasis SIP bernama EKIGA, yang bekerja dengan baik pada semua 
USB webcam atau Headphones

Ekiga  adalah  aplikasi  default  SIP  dan  H.323  yang  disertakan  ubuntu  sebagai  aplikasi  VoIP,  IP 
telephony. dan Video conference dengan softphone. Aplikasi ini mendukung audio dan video yang di  
salurkan melalui Internet, dapat dilakukan oleh sesama user yang juga menggunakan SIP atau H.23. 
Ekiga kompatibel dengan windows Messenger dan beberapa apikasi VoIP. Berikut ini tampilan Ekiga 
di desktop Ubuntu Intrepid:

gambar 1: Fasilitas Search



Accessx-status 

Menunjukkan aksesibilitas pengaturan keyboard, termasuk kondisi keyboard saat itu, jika ada fitur yg 
sedang  berjalan,  juga  menampilkan  preview yang dapat  di  print,  sebagai  panduan  apabila  anda 
kesulitan menggunakan keyborad asing anda.

Battstat 

Battstat digunakan untuk memantau penggunan power/konsumsi batere jika digunakan pada laptop

gambar 2: Ekiga

gambar 3: Accessx-keyboard



Character palette 

Character palette untuk menyediakan cara mudah untuk mengakses karakter  non-standar,  seperti 
karakter, simbol matematika, simbol-simbol khusus, dan tanda baca.

GNOME CPUFreq Applet

memantau frekuensi CPU

Geyes 

Merupakan aplikasi mainan yang berupa sepasang mata yang mengikuti pergerakan mouse di layar.

gambar 4: Battery-status

gambar 5: character palette

gambar 6: Cpu freq



Keyboard layout switcher 

memungkinkan Anda menggunakan keyboard yang berbeda layout

Mixer 

volume control yg disempurnakan

Modem Monitor: 

memantau kinerja modem

System monitor: 

memantau kinerja CPU, memory, network, swap file dan resource lainnya

Weather report 

melaporkan kondisi cuaca terkini langsung pada desktop

 

gambar 7: volume mixer

gambar 8: System monitor



Nautilus

GNOME juga meningkatkan kemampuan file manager berbasis Tab bernama Nautilus, yang juga bisa 
menampilkan ikon untuk removable drive di sidebar

Kemampuan nautilus sebagai file manager yang multi fungsi:

• Fungsi mode Browser:

1. Jendela File Browser: Pada mode ini anda akan dapat memanfaatkan Nautilus untuk melihat file 
file  anda yang terdapat pada suatu direktori,  dengan 3 mode view (Icon View,List  View dan 
Compact  View),masing  masing-masing  mempunyai  kegunaan  yang  berbeda,  misalkan 
penggunaan list View akan memudahkan kita untuk melihat informasi detil dari properties file,  
waktu pembuatan, ukuran file, author dan lain sebagainya.

2. Menampilkan FIle Hidden/Unhidden Files, secara default Nautilus tidak akan menampilkan file 
yang  atributnya  hidden  (file  berawalan  tanda  titik  didepannya  ".*"),  untuk  lingkungan  kerja 
desktop linux, file dengan awalan "." akan dianggap sebagai file hidden, untuk menampilkan file 
ini dengan langkah sebagai berikut:

• Dengan GUI: View » Show Hidden Files

• Dengan shortcut: CRTL + H

3. Menampilkan Location Bar: Bagian ini memudahkan anda untuk mengakses direktori yang ingin 
anda tuju, untuk menampilkan location bar dengan cara  View → Location Bar. Ada 2 mode 
yang ditawarkan untuk location bar:

• Tab Mode, ini semacam history apabila kita mengakses subfolder yang ada didalamnya 
akan secara otomatis terekam di tab atas, direktori dianggap sebagai blok blok yang dapat 
diakses dengan cepat dengan mengklik pada blok yang ingin dikunjungi:

 

gambar 9: weather info

gambar 10: tabbing di nautilus



• URL Mode, mode ini lebih disukai apabila kita sudah mengetahui lokasi file yang ingin kita 
akses, caranya dengan menuliskan alamat pada Location bar pada bagian atas sebagai 
berikut:

1. Menampilkan  beberapa  lokasi  sekaligus  pada  satu  Jendela  dengan  menggunakan 
fasilitas  Multi  Tab  pada  Nautilus  2.24.1:  Ubuntu  intrepid  ibex  sudah  menggunakan 
nautilus yang mendukung penggunaan Tab, seperti halnya pada konqueror atau mozilla 
firefox, dengan adanya tambahan fitur pada file manager ini akan lebih memudahkan 
kita dalam pengelolaan file dan manajemen lokasi, kita dapat mengakses lokasi tertentu 
pada masing-masing tab pada satu jendela saja. Untuk mennggunakan fasilitas Tab ini 
File  → New Tab atau dengan shortcut CTRL + T:

2. Menggunakan side panel untuk memudahkan navigasi anda: Bagian side panel secara 
default  akan  menampilkan  direktori  home  dan  device  yang  ter-mounting(terkait)  di 
sistem, untuk menampilkan side panel dengan cara men-checklist View  → Side Panel 
atau dengan menggunakan shortcut F9. Beberapa mode yang dapat kita gunakan pada 
bagian side panel:

• Mode Place : Pilih pada menu drop down bagian side panel pada mode  Place. 
Mode  ini  menampilkan  Home  Directory,  Device  yang  ter-mounting(terkait)  dan 
Bookmark yang sudah kita buat. Bookmark adalah semacam shortcut untuk menuju 
lokasi tertentu yang ingin kita kunjungi, cara penambahan bookmark adalah dengan 

gambar 11: tab location

gambar 12: location url mode

gambar 13: membuat tab baru



cara  mengakses  dauhulu  lokasi  yang  ingin  kita  bookmark  kemudian  Pilih  pada 
menu  bar  Bookmark  » Add  bookmark,  nanti  akan  secara  otomatis  lokasi 
bookmark  akan  ditampilkan  pada  side  panel  dan  dapat  dengan  cepat  untuk 
mengakses lokasi tersebut.

• Mode  Information:  Pada  mode  ini  akan  menampilkan  informasi  mengenai 
folder/lokasi  yang anda kunjungi,  informasi yang ditampilkan antara lain tipe dan 
jumlah  file  yang  ada  di  dalamnya.  Jika  anda  memiliki  file  manager  lain  seperti 
Dolphin, Konqueror atau Thunar, akan ditampilkan disini juga sebagai alternatif file 
manager.

• Mode Tree :  Menampilkan  pohon direktori,  kita  dapat  meilhat  susunan direktori 
dengan mem-browse pada file  induk  dan akan ditampilkan hierarkinya,  ini  akan 
memudahkan kita dalam mengingat lokasi, karena ditampilkan secara visual, lain 
halnya dengan penggunaan mode place, kita harus benar-benar hafal lokasi yang 
ingin kita kunjungi.

• Mode History :  Menampilkan sejarah direktori  yang sudah pernah kita  kunjungi 
pada  saat  operasi  menggunakan file  browser,  mode ini  bermanfaat  apabila  kita 
melakukan  operasi  yang  berulang-ulang  pada  direktori  tertentu,  juga  sebagai 
pengingat lokasi mana saja yang sudah kita kunjungi.

• Side Panel Note : Bagian ini kita dapat menambahkan catatan lokasi

• Side  Panel  Emblems :  Kita  dapat  menambahkan  emblem  pada  direktori,cara 
memberikan emblem ini  dengan drag emblems dari  side panel ke direktori  yang 
ingin kita beri emblem

3. Menggunakan  side  penel  untuk  mounting  dan  unmounting  media:  Untuk 
menggunakan fasilitas  mounting  ini,  side  panel(F9)  harus  pada mode  Places,  pada 
media side panel akan ada icon yang digunakan untuk me-mount (memasang) device, 
seperti removable disk, hardisk atau media lainnya. untuk melepaskan removable media 
cukup dengan mengklik pada ikon umount pada bagian kanan Label device:

• Fungsi mode Remote: fungsi ini mendukung untuk koneksi ke server via remote, dapat digunakan juga 
sebagai  ftp  manager,  untuk  mengakses  koneksi  dengan  server  lakukan  File » Connect to 
Server pada jendela ini terdapat menu pilihan tipe koneksi yang dapat di pilih, dintaranya : SSH, FTP 
(with  login),  Public  FTP ,  Windows  Share  (Samba),  Webdav(HTTP),  atau  custom location.  untuk 
terhubung dengan server silakan pilih koneksi yang tersedia dan masukkan informasi yang dibutuhkan 
untuk dapat login, seperti :alamat IP atau Domain, user, password dan port:

gambar 14: tombol eject/unmounting



• Jika anda sudah terbiasa dengan custom location, maka koneksi ke server juga akan lebih mudah, 
cukup  dengan  mengetikkan  pada  url  dengan  alamat  dan  user  yang  ingin  digunakan:  misalkan 
penggunaan sebagai berikut:

1. koneksi via FTP : ftp://user@alamat-server.com

2. koneksi via SSH : ssh://user@alamat-server.com

3. koneksi via SFTP : sftp://user@alamat-server.com

• Gnome 2,24 juga menyediakan banyak perangkat tambahan yang diperlukan untuk pengguna mobile, 
dengan dukungan Bluetooth yang lebih baik dan dukungan Offline untuk akses ke server Exchange 
menggunakan aplikasi Evolution

➔ X.Org 7.4
X. Org 7,4 pada Ubuntu 8.10 Intrepid Ibex ini tidak memiliki banyak perubahan, namun X.Org 7.4 telah bisa 
menyelesaikan beberapa masalah yang terasa mengganggu, misalnya : 

• Dukungan  Hotplug untuk perangkat input bisa bekerja dengan baik sekarang, sehingga anda dapat 
mencolokkan mouse dan tablets serta bisa langsung menggunakannya tanpa harus reboot;

• Display Control yang lebih baik,User dapat mengatur resolusi dan penempatan layar untuk single dan 
multiple monitor dengan lebih mudah;

gambar 15: nautilus remote login

gambar 16: contoh ftp di nautilus



• xserver-xorg-input-all akan hadir untuk menerima berbagai macam perangkat input;

• Window System development libraries akan ikut disertakan;

• X.Org  X  Window System akan  hadir  dengan level  metapackages  yang lebih  tinggi.  Hal  ini  akan 
memberikan peningkatan kinerja pada komponen standalone workstation untuk menjalankan X Window 
System.

➔ Linux Kernel 2.6.27
Kernel  2.6.27,  seperti  biasa  jika  ada  upgrade,  menawarkan  perpaduan  antara  peningkatan  kinerja, 
penambahan fitur-fitur baru, dan dukungan untuk hardware baru, diantaranya :

• Peningkatan kecepatan akses pada EXT4 file system

• support yang lebih baik untuk USB webcams

• Peningkatan daya tahan batere untuk mobile user

• 2.6.27 menghadirkan filesystem baru (UBIFS) dioptimalkan untuk media penyimpanan berbasis flash

• Ada banyak penambahan modules juga. anda akan melihat banyak perubahan jika sudanh menginstall 
dan membandingkan.

• DKMS (by Dell) included dalam paket Ubuntu 8.10, memungkinkan driver kernel yang akan dibangun 
kembali secara otomatis ketika ada update kernel baru yang dirilis.

➔ Encrypted Private Directory
Private Directory yang dienkripsi mungkin adalah fitur baru paling signifikan di Ubuntu 8.10 Intrepid Ibex.  
Aplikasi  ini  membantu  user  dengan  memberikan  standar  lokasi  aman  untuk  menyimpan  data  sensitif 
menggunakan filesystem enkripsi, ~ / Private untuk setiap pengguna dengan permission 700.

➔ Guest Session
User switcher panel sekarang memberikan masukan tambahan untuk memulai sebuah sesi Tamu (guest 
session), dengan menyediakan temporary password-less user account dengan hak terbatas semisal : 

gambar 17: display control



• Account ini tidak dapat mengakses semua ‘home direktori’

• Account ini tidak dapat menyimpan data secara permanen

• Ini adalah fitur yang sangat berguna bagi siapa saja yang sering meminjamkan komputer atau laptop 
kepada orang lain, karena kemanan data akan lebih terjamin.

➔ Network Manager 0.7
Network  Manager  pada  Ubuntu  8.10  Intrepid  Ibex  ini  merupakan  perbaikan  yang  signifikan  dari  rilis 
sebelumnya. Menyediakan sejumlah fitur yang menarik seperti :

• memungkinkan mesin Ubuntu anda terhubung ke jaringan sebelum user log in

• mendukung konektivitas 3G

• memungkinkan Multiple simultaneous connections

• Sets up PPPoE

• Manajemen devices dengan konfigurasi static IP

• Route management untuk devices

• Dukungan untuk Wifi yang jauh lebih baik dan dengan konfigurasi yang lebih mudah

Berikut ini gambar tampilan Network Manager Pada ubuntu Intrepid Ibex

➔ Samba 3.2
Samba 3.2 suite adalah kumpulan program yang menerapkan protokol  SMB / CIFS untuk sistem unix, 
memungkinkan Anda untuk  melayani  sharing file  dan  printer  ke Windows,  NT,  OS /  2  DOS dan klien. 
Iprotokol ini juga disebut sebagai LanManager atau protokol NetBIOS. Paket-paket yang terinstal di Samba 
3.2 ini antara lain :

• samba-common (Samba common files baik yang digunakan oleh server atau client)

gambar 18: network manager



• samba-tools (tools yg disediakan oleh Samba suite)

• smbclient (a LanManager-like simple client untuk Unix)

• swat (Samba Web Administration Tool) dan lain2.

Samba 3.2 memberikan dukungan (support) yang lebih baik kepada user, misalnya :

• clustered file server support

• encrypted network transport

• ipv6 support

• Integrasi yang lebih baik dengan server dan klien dari versi terbaru Microsoft

➔ Dukungan untuk Web Audio/Video yang lebih baik
Ubuntu saat ini mendukung pengaturan kualitas tinggi untuk YouTube. Selain itu pada Ubuntu 8.10 Intrepid 
Ibex ini tersedia plugin baru untuk Totem movie player yang bisa mengunduh konten digital gratis dari BBC.  
Caranya : Start Totem 

  (Applications -> Sound & Video -> Movie Player),
enable the plugin 

  (Edit -> Plugins -> BBC content viewer)  dan pilih  “BBC”

➔ Live CD Installer Updates
Desktop  installer  menyajikan  slide-show  ketika  menyalin  file  untuk  menjelaskan  konsep  baru  kepada 
pengguna sementara mereka menunggu. Desktop installer berisi banyak perangkat visual tambahan, seperti 
gambar tabel partisi dan password strength meter. LiveCD Acceleration Toolkit akan ikut disertakan

➔ Live USB
Ubuntu  mengembangkan  aplikasi  untuk  mengkonversi  Ubuntu  CD images  ke  sebuah  media  flashdisk. 
sehingga akan lebih mudah untuk menginstal Ubuntu 8.10 Intrepid Ibex ini pada sebuah flash disk.

Instalasi Ubuntu 8.10 Intrepid Ibex

Apa itu DualBoot
Dual boot adalah suatu kondisi dimana dalam satu buah komputer terdapat sistem operasi lebih dari dari.  
Dalam bidang installasi Linux, istilah dualboot ini sering digunakan untuk menyebutkan sistem operasi Linux 
yang  terinstall  berdampingan  dengan  sistem  operasi  windows.  Walaupun  dualboot  dapat  sangat 
memungkinkan untuk mendampingkan Linux dengan sistem operasi lain seperti Mac, Solaris, BSD, bahkan 
sesama  Linux  sendiri  yang  berbeda  distro,  dualboot  yang  akan  dibahas  disini  adalah  dualboot  yang 
berkaitan dengan Linux dan windows.

Mengapa menggunakan DualBoot
Alasan  yang  sering  menjadikan  dasar  proses  dualboot  adalah  rasa  tidak  tega  atau  tidak  ikhlas  untuk  
menghapus sistem operasi yang sebelumnya. Selain itu, juga karena ada beberapa aplikasi yang belum 
ditemukan  penggantinya  di  sistem operasi  Linux,  dan  menjalankan  aplikasi  tersebut  di  sistem operasi 
windows adalah jalan keluar yang masuk akal untuk kondisi tersebut.



Syarat Menggunakan DualBoot
Agar sebuah komputer dapat dipasang dua buah sistem operasi, tentunya syarat utama yaitu ukuran space 
harddisk yang cukup besar sehingga dapat menampung sistem operasi-sistem operasi  tersebut dengan 
nyaman.

Langkah-langkah mempersiapkan DualBoot

 

➔ System exist
Langkah-langkah ini di asumsikan dilaksanakan dari komputer yang mana sitem operasi windows telah exist 
didalamnya :

1. Pilih partisi (drive) mana yang ingin disiapkan untuk diletakkan sistem operasi Linux;

2. Backup content ata data yang terdapat di partisi (drive) tersebut;

3. Jika dimungkinkan, dan/atau di  Windows terdapat aplikasi  pengatur  partisi,  siapkan dahulu partisi 
yang akan digunakan di linux. Partisi yang disiapkan ialah:

1. partisi ext3/resiserfs untuk system setidaknya berukuran 5GB hingga 10GB;

2. partisi untuk swap yang ukurannya disesuaikan dengan RAM fisik yang digunakan;

3. partisi ext3/reiserfs untuk home pada sisa partisi yang dibuat.

➔ System baru
Apabila komputer masih baru dan harddisk masih kosong, langkah-langkah untuk mempersiapkan Dualboot 
adalah sebagai berikut:

1. Atur partisi  menjadi  primary dan extended. Partisi  primary umum akan dibaca sebagai hda1 atau 
sda1, sedangkan partisi extended akan dibaca mulai dari hda5 atau sda5;

gambar 19: contoh pembagian partisi



2. Susun kebutuhan ukuran dan jenis filesystem untuk hda1, karena partisi ini akan menjadi drive C di 
windows;

3. bagilah partisi extended menjadi beberapa partisi;

4. partisi extended pertama, (sda5) atur ukuran dan jenis filesystem karena akan digunakan sebagai  
drive D di windows;

5. partisi extended kedua, (sda6) beri ukuran sekitar 5GB hingga 10GB untuk digunakan sebagai root 
system dari Linux. Jenis filesystemnya bisa digunakan ext3 atau reiserfs;

6. partisi extended ketiga, (sda7) beri ukuran secukupnya dengan RAM fisik, atau bisa juga sekitar 1GB 
hingga 2GB untuk digunakan sebagai partisi SWAP;

7. partisi extended keempat, (sda8) cukup gunakan saja sisanya untuk digunakan sebagai partisi home;

8. installah windows terlebih dahulu hingga selesai. Abaikan jika windows tidak dapat membaca partisi 
ext3 atau reiserfs;

9. installah Linux, dan biarkan bootloader mendeteksi secara otomatis sistem operasi windows.

Mempersiapkan Partisi
Penggunaan partisi di gunakan untuk lebih mengeffisienkan ukuran media harddisk. Misalkan ada direktori  
yang oleh sistem tidak selalu diisi oleh banyak file, dapat diberikan partisi yang kecil saja.

Pengaturan partisi di linux, untuk mode grafis dapat menggunakan gparted. Untuk melakukan proses operasi 
partisi di harddisk baru, silahkan gunakan gparted-live-cd agar pengoperasian partisi dapat lebih optimal.

Sekilas Tentang Partisi

➔ Partisi ibarat penyekat
Ambillah asumsi, analogi, ataupun anggapan, bahwa harddisk yang anda gunakan adalah sebuah gedung 
ataupun ruko. Gedung yang anda miliki memiliki berbagai macam luasnya ada yang 40m2, 60m2, 80m2, 
120m2 bahkan kini ada yang mencapai 300m2. Selanjutnya, apa yang anda bayangkan dengan gedung 
yang berukuran 80m2 tersebut? Tentunya jika ingin digunakan tempat usaha atau kantor, akan kesulitan jika 
satu ruangan 80m2 digunakan tanpa penyekat, kecuali memang anda berencana menyewakan sebuah aula. 
Agar mudah dalam mengatur ruangan, maka gedung seluas 80m2 perlu dibagi-bagi dengan penyekat. Nah,  
penyekat inilah yang akan membagi gedung seluas 80m2 menjadi tempat kerja yang efektif.

Pertanyaan  selanjutnya,  jika  ingin  dibagi,  berapa  luasan  ruang  tiap-tiap  sekatan?  Nah..  jawaban  dari 
pertanyaan ini sangat tergantung dengan penggunaan ruangan tersebut. Ruangan yang menyimpan barang-
barang besar seperti  kulkas, mesin fotocopy, printer outdor, bahkan mobil tentunya membutuhkan ruang 
yang besar. Juga berlaku sebaliknya, untuk ruangan yang menyimpan barang-barang kecil, seperti sapu,  
pengki, dan semacamnya tidak perlu ruangan yang besar.

Terus, bagaimana jika anda tidak yakin dengan isi ruangan anda?

Cara  yang  paling  sederhana  yaitu  ruangan  hanya  dipisahkan  tiga  macam,  ruangan  direktur,  ruangan 
penyimpanan,  dan  ruangan  kerja.  Ruangan  direktur  ini  adalah  letaknya  sistem  anda  utama  dipasang, 
ruangan direkur yang ideal tidak perlu terlalu luas, cukup untuk dapat digunakan bekerja saja. Karena begitu  
tempat  usaha anda sudah berjalan,  tentunya ruangan direktur akan menjadi  ruangan yang paling repot  
untuk diubah.

➔ Filesystem ibarat susunan ruangan
Setelah gedung seluas 80m2 disekat-sekat, tentunya agar bisa digunakan kerja, anda perlu menata hasil  
penyekatan tersebut. Tentunya penataan ruangan untuk staff dan untuk direktur bisa dibuat sama dan bisa 



berbeda, tergantung selera.

Kenapa kita perlu menata ruangan hasil sekatan? Tentunya penataan ini untuk menentukan dimana letak 
meja dan kursi, dimana kita duduk dan menghadap kemana, tidak lain tidak bukan, tujuan penataan ini untuk  
kelancaran kerja. Penataan yang baik dan sesuai dengan pola kerja yang digunakan akan menghasilkan 
kerja yang optimal.

Di dalam ilmu komputer, filesystem, atau susunan sebuah partisi, dikenal banyak sekali. Misalkan filesystem 
FAT16, FAT32, dan NTFS yang identik untuk bekerja di lingkungan windows. Atau filesystem EXT2, EXT3,  
ReiserFS  yang  umum  digunakan  untuk  bekerja  di  lingkungan  Linux.  Perbedaan  masing-masing  jenis 
filesystem tidak akan dibahas disini karena penjelasan yang diberikan akan terlalu teknis. Pembacaan antar  
filesystem tergantung  pada sistem operasinya.  Ibaratnya,  seorang  direktur  dia  mampu  bekerja  dengan 
susunan apa saja, apabila si direktur hanya menerima satu macam susunan tempat kerja, maka apabila ada 
staf yang dengan beraninya mengubah susunan tempat kerjanya akan ditegur karena akan menghambat  
kerja rekan-rekannya yang lain.

➔ SWAP serupa dengan RAM cadangan
Dalam proses installasi Linux partisi yang umum digunakan adalah EXT3 dan satu macam partisi SWAP.  
Partisi dengan filesystem SWAP ini bekerja sebagai cadangan apabila RAM yang digunakan penuh. Apabila 
seorang direktur adalah processor, maka RAM-nya adalah meja kerjanya, dan ruangan kerjanya adalah inti 
dari sistem operasi. Pada saat si direktur bekerja, maka meja kerjanya akan ditumpuk berkas-berkas kerja 
yang harus dikerjakan. Semakin banyak tugas yang harus diselesaikan si direktur, maka tumpukan berkas di  
meja pun akan semakin membengkak. Jika tumpukan berkas itu terus dibiarkan menumpuk, maka si direktur  
tidak dapat bekerja. Tempatnya untuk bekerja habis, padahal tumpukan berkas semakin menggunung. Hal  
ini menyebabkan si direktur menjadi stress, bingung, lalu pingsan dan perlu direstart.

Untuk mencegah si direktur menjadi stress, bingung lalu pingsan, maka perlu disediakan ruangan tersendiri 
yang akan menampung berkas-berkas yang sedang dikerjakan oleh direktur. Ruangan ini adalah SWAP. 
Dikala meja kerja direktur sudah dirasa cukup penuh, dan berkas kerjaan terus berdatangan, maka berkas 
tersebut  akan diletakkan di  ruangan SWAP. Dengan cara ini,  maka kelegaan meja kerja direktur dapat 
terjaga, dan si direktur dapat terus bekerja dengan ceria, sentosa dan bersahaja.

Awas,  untuk  menentukan  ruangan  SWAP  ini  juga  perlu  diperhatikan.  Ruangan  SWAP  memang  tidak 
memerlukan ruangan yang luas,  tapi  juga jangan terlalu  sempit.  Jika  limpahan berkas  di  meja  direktur 
ternyata memenuhi ruangan SWAP sehingga ruangan SWAP tidak mampu menampung berkas kerjaan lagi,  
maka kondisi direktur pun akan kembali ke semula, si direktur akan stress, bingung, lalu pingsan dan perlu 
direstart.

Dengan melihat spesifikasi komputer akhir-akhir ini, partisi swap cukup berukuran antara 500 MB hingga 
1500 MB. Jika anda cukup yakin dengan apa yang akan anda kerjakan sehari-hari, anda dapat mengubah 
sendiri ukuran swap yang digunakan.

➔ Mount Point ibarat penempatan
Setelah partisi dibuat, filesystem ditentukan, maka selanjutnya perlu diberikan mount point-nya.

Dalam  sebuah  tempat  usaha  yang  sederhana,  tentunya  juga  memiliki  struktur  organisasi  sederhana. 
Masing-masing bagian agar dapat berkerja perlu diberikan jatah untuk menempati ruangan yang disediakan.  
Mengikrarkan penempatan ini sangatlah penting, kalau perlu dibuatkan SK-nya. Karena jika tidak di ikrarkan,  
maka ruangan yang sebelumnya repot-repot disekat, lalu repot-repot ditata posisi meja dan kursinya, tidak 
bakal ada yang menempati.

Staf tidak akan berani iseng-iseng menempati ruangan sekatan yang tidak di jatahkan untuk dirinya. Setelah  
si  direktur  memnentukan  atau  mengubah  mount  point,  maka  staf  baru  boleh  berpindah  antar  ruangan 
sekatan.

Secara umum, mount point hanya perlu diisikan root system (tanda slash '/'), kemudian home (tanda /home) 
dan SWAP.

Untuk  perangkat  yang  datang  kemudian,  maka  secara  umum  akan  diberikan  mount  point  didalam 
directory /media.



➔ Drive C:-nya mana?
Didalam sistem operasi linux tidak mengenal permodelan drive. Seperti yang sudah di jelaskan sebelumnya, 
partisi yang dibuat akan langsung di berikan penugasan untuk diisi oleh directory apa saja. Dengan model  
penugasan ini, maka system akan lebih mudah mengenal tempat kerjanya.

Untuk cd-rom, usb disk, harddisk external,  seperti  yang dijelaskan sebelumnya, anda dapat menemukan 
perangkat penyimpanan anda di directory /media.

Jika  perangkat  penyimpanan  seperti  cd-rom,  usb  disk,  harddisk  external,  ibarat  sebagai  tamu,  maka 
directory /media adalah ruang tamunya. Tamu-tamu yang berurusan dengan tuan rumah akan diterima di  
ruang tamu. Oleh karena itu, anda jangan sampai lupa, dimana letak ruang tamu anda.

Lain ceritanya apabila tamu itu memang sudah dikenal baik oleh si empunya rumah. Maka tuan rumah sah-
sah saja untuk menerima tamu tersebut didalam, di ruang keluarga, ruang makan, bahkan ruang tidur.

Untuk pengaturan mount point, dapat diatur di file /etc/fstab. Penggunaan file ini tidak dibahas dahulu disini.

Partisi dalam istilah teknis
Partisi  yang  dalam pengaturan  media  penyimpanan adalah  bagian  dari  memori  harddisk  yang  terpisah 
secara logika dan tidak terpisah secara fisik. Partisi ini dapat diterapkan di berbagai media penyimpanan,  
seperti flashdisk dan sebagainya, tapi secara umum, partisi memang sering dipakai di media Harddisk.

Partisi  didalam disk  dapat  dibuat  dengan menggunakan tool  pembuat  partisi  seperti  fdisk,  cfdisk,  atau 
parted.  Untuk  berbasis  GUI,  dikenal  Gparted  dan  QtParted.  Untuk  lingkungan  windows,  umum dikenal 
partition magic. Setelah partisi dibuat, maka partisi itu perlu diformat dengan file system tertentu. Secara 
umum, setiap tool partisi juga menyertakan fasilitas untuk membuat filesystem.

Pada sistem x86 yang umum kita pergunakan, skema partisi yang hanya dapat dibuat empat macam partisi 
yang umum disebut primary partition (partisi primer). Oleh karena itu, untuk membentuk suatu partisi yang 
lebih banyak perlu dibuat partisi tambahan, dimana dalam partisi tersebut, dapat dibuat partisi yang lain yang 
kemudian disebuat Extended Partition (partisi extensi). Dalam sebuah harddisk, hanya perlu memiliki satu 
buah extended Partition, karenda dari extended partition ini, dapat dibuat partisi-partisi lain yang lebih kecil 
dan lebih banyak. 

Untuk Primary Partition, tidak ada ketentuan pasti apakah primary partition hanya boleh satu saja atau harus 
digunakan seluruhnya. Yang jelas,  untuk kesehatan sistem operasi,  untuk keperluan booting,  sebaiknya 
diletakkan di Primary Partition. Untuk sistem operasi Linux saat ini, sudah mampu melakukan boot walau 
tidak  harus  system  terinstall  di  primary  partition.  Untuk  kasus  beberapa  distro  yang  masih  strict  
mengharuskan diisntal di primary partition.

➔ Tujuan Menggunakan Partisi
• Memisahkan sistem operasi dengan file-file pengguna

• Memiliki ruang untuk swap dan virtual memori

• Membuat data data yang sering digunakan dapat terletak berdekatan

• Untuk memisahkan cache dan file-file log terpisah dari file-file lainnya. File-file tersebut dapat berubah 
dengan sangat sepat, dan berpotensial menyebabkan partisi cepat penuh

• Untuk melakukan multi-boot atau dual-boot. Sehingga satu harddisk dapat tersimpan dua macam atau 
lebih sistem operasi.

• Untuk  melindungi  atau  mengisolir  file.  Hal  ini  agar  mempermudah untuk  menyelematkan data  dan 
memisahkan apabila terjadi partisi korup.

➔ Bentuk partisi pada DOS dan Windows
Pada Dos dan Windows, skema partisi standar yaitu dengan membuat partisi utama tunggal yang disebut 



sebagai drive C. Di partisi tersebut tersimpan sistem operasi, data pengguna, aplikasi, dan data yang lain 
pada partisi yang sama. Beberapa pengguna, menyenangi untuk membuat partisi jamak sehingga sistem 
operasi dapat tersimpan tersimpan terpisah dari data-data yang lain. Kelebihan dari menggunakan partisi  
lebih dari satu yaitu dapat dengan mudahnya menghapus. Apabila ditambah dengan menggunakan aplikasi 
berbayar seperti Acronis disk director, Norton Partition Magic, akan sangat memudahkan pengguna untuk 
mengembalikan  komputernya  yang  terjangkiti  virus  atau  permasalahan  lain  yang  mengacaukan  sistem 
operasi DOS atau windows. 

➔ Skema Partisi pada Linux
Pada sistem operasi berbasis Unix dan Unix-like seperti Linux dan Mac OS X, pembuatan partisi terpisah 
untuk /boot, /home, /tmp, /usr, /var, /opt, swap dan seluruh file yang lain sangatlah memungkinkan. Skema 
partisi  seperti  itu  memiliki  beberapa keuntungan,  jika  salah satu  filesystem mengalami  kerusakan,  data 
ataupun file-file milik sistem operasi tidak akan bermasalah. Untuk meningkatkan keamanan dari kehilangan 
data sistem, partisi dapat dibuat read only. Metode dengan membagi partisi menjadi ukuran yang fix juga 
memiliki  beebrapa ketidak-  nyamanan,  salah  satunya  yaitu  pengguna dapat  kehabisan  space  di  partisi 
/home, walaupun space di partisi lain masih tersisa banyak. Oleh karena itu, pengguna hendaknya mampu 
memprediksikan rencana penggunaan partisinya, yang hal ini dapat menyulitkan pengguna baru.

Logical  Volume Management  (LVM),  sering digunakan di  perangkat  server.  Kelebihan LVM yaitu  dapat 
dengan mudahnya diatur ukuran partisi. Yang berbeda dari LVM ini yaitu LVM terikat memiliki tool tersendiri  
untuk mengubah ukuran partisinya, dan tidak memerlukan tool khusus untuk mengatur partisinya. LVM juga 
tidak  hanya  berkemampuan  untuk  menggeser  partisi  secara  langsung,  tetapi  juga  dapat  untuk 
'menyambung' harddisk sehingga menjadi dikenali sebagai satu buah partisi yang lebih besar. 

➔ Filesystem di Sistem Operasi Linux
Sistem operasi linux membuat semacam file sistem virtual yang dapat membuat seluruh file akan tertampil  
berada dalam hirarki tunggal. Hal ini berarti, di filesystem itu hanya terdapat satu buah root directory, dan 
seluruh file yang ada akan terletak dibawahnya di suatu tempat lain. Selain itu juga, root directory tidak harus 
berada ditempatkan secara fisik  di  harddisk anda, mungkin dapat  juga tidak terletak di  komputer  anda. 
Sistem di Linux dapat menggunakan jaringan sebagai root directorynya.

Sistem  Linux  memberikan  nama  device  untuk  masing-masing  device,  tapi  ini  bukanlah  bagaimana 
menunjukkan cara file  didalam device itu  diakses.  Untuk mendapatkan pengaksesan file  didalam suatu 
device, anda harus memberitahukan dulu ke sistem operasi di directory mana anda menginginkan file-file  
tersebut  untuk  muncul.  Proses  inilah  yang  disebut  dengan  mounting.  Sebagai  contoh,  untuk  dapat 
mengakses file-file  yang ada di  CD-ROM,  anda harus  memberitahu sistem operasi  kurang lebih  begini 
“Ambil filesystem yang di CD-ROM lalu munculkan di directory contohnya dengan nama directory belajar”.  
Nah directory yang diminta untuk menampilakan file itu tadi yang disebut sebagai mount point.  Sebagai 
contoh, adalah directory didalam /media. Directory /media sangat mudah ditemui di banyak sistem Linux 
yang menggunakan kernel 2.6.x seperti yang sudah di spesifikasikan dalam Filesystem Hierarchy Standard. 
Direcroty /media ini di spesifikasikan untuk mengelompokkan mount point dari berbagai macam removeable 
media, seperi CD, DVD, flash disk, handy cam, MP3 player, memcard reader, iPod, dan juga floppy disk 
kalau masih ada. Isi dari /media bia saja kosong, atau berisi beberapa directory kosong untuk mounting 
masing-masing device, atau bisa juga tiba-tiba berisi directory jika media itu dibaca sistem. Proses tiba-tiba 
muncul itu yang dikenal dengan istilah automount. Secara umum, hanya root atau administrator yang di pilih 
yang diperbolehkan untuk melakukan mounting.

Sistem Linux sering menyertakan software atau tool  untuk membantu proses mounting dan mendukung 
fungsionalitas baru. Salah satu diantaranya adalah auto-mount itu tadi, dengan tujuan sebagai berikut

• Di bebarapa situasi, file sistem selain root perlu tersedia bersamaan dengan sistem operasi menyala. 
Seluruh sistem Linux menyediakan fasilitas mounting saat system menyala. Fasilitas itu disebut fstab. 
Sysadmin mendefinisikan filesystem apa saja yang dibutuhkan kedalam /etc/fstab beserta dengan opsi 
dan mount pointnya.

• Di beberapa situasi, tidak diperlukan untuk melakukan mount pada file sistem tertentu saat booting, 
diakrenakan file sistem itu dibutuhkan saat setelah proses boot selesai.



• Removeable media menjadi sesuatu yang umum untuk perangkat rumahan dan notebook. Misalnya 
yaitu Flash disk, CD ROM, dan DVD. Beberapa sistem Linux juga dilengkapi aplikasi untuk mendeteksi  
kehadiran dari media tersebut dan segera melakukan mount tanpa ada campur tangan pengguna.

➔ Master Boot Record
Master Boot Record adalah sebutan untuk sektor yang paling ujung awal dari sebuah harddisk. Didalam 
MBR terdapat hal-hal seperti berikut:

• Kode booting ke sistem operasi,  kode booting ini  yang membuat harddisk dapat booting ke sistem 
operasi. Kode ini disebut juga dengan Master Boot Code. Boot loader seperti Lilo dan Grub terletak di  
sini.

• Tabel partisi yang berisi daftar partisi apa saja yang terdapat pada harddisk yang digunakan.

Pada saat booting, MBR bertugas sebagai berikut:

• Mencari partisi yang aktif atau yang dapat digunakan untuk booting dalam tabel partisi.

• Mencari sektor pertama dari partisi yang digunakan untuk booting.

• Memuat salinan boot sector dari partisi aktif kedalam memori

• Memberikan kontrol kelanjutan kepada kode untuk dieksekusi selama proses boot.

Pengaturan partisi mode grafis
DI  Linux  saat  ini  juga  telah  menyediakan  tool  untuk  mengatur  partisi.  Salah  satunya  adalah  Gparted.  
Gparted ini selain merupakan aplikasi yang terinstall kedalam sistem, juga terdapat dalam bentuk liveCD 
yang memudahkan untuk mengatur partisi suatu harddisk yang sama sekali belum memiliki sistem operasi. 

➔ Memulai Gparted
Pada saat Gparted dijalankan akan muncul jendela seperti pada dan partisi dan harddisk akan di scan

Jika kemudian kita klik pada menu Gparted (yang berada pada pojok kiri atas), sebuah pop down menu akan 
muncul. Kita dapat memilih tombol refresh untuk menampilkan partisi yang terdapat pada sistem.

Kemudian di menu bawahnya, kita dapat memilih harddisk mana yang ingin kita ubah partisinya. Opsi ini 

gambar 20: Tampilan Depan GParted



sangat  berguna  jika  kita  memasang  harddisk  lebih  dari  satu.  Menu  yang  ketiga  yaitu  menu  untuk 
mendapatkan informasi harddisk.

Di Menu itu kita dapat melihat bagaimana dukungan gparted terhadap file system tertentu. Tabel dukungan 
itu seperti yang ditunjukkan pada gambar 22.

Kemudian menu Edit terletak pada posisi kedua dari kiri. Menu itu menunjukkan dua fungsi yang belum aktif. 
Menu tersebut adalah Undo dan Apply menu ini sangat berguna dalam mengatur partisi. Opsi ini juga dapat 
ditemu  di  toolbar.  Untuk  mengaktifkan  menu  tersebut,  kita  diharuskan  memilih  salah  satu  partisi  yang 
hendak di modifikasi. Menu Edit seperti yang ditunjukkan pada gambar 23

gambar 21: Menu PopDown GParted

gambar 22: Tabel fitur gparted



Menu View, gambar 24, digunakan untuk mengatur tampilan pada aplikasi Gparted.

Harddisk Information (gambar 25) : Pada bagian paling kiri dari daftar partisi akan tertampil panel harddisk 
information. Panel ini menunjukan informasi harddisk secara rinci meliputi Model harddisk, ukuran, geometri,  
dan lain sebagainya. Panel ini sangat berguna jika digunakan pada sistem yang memiliki banyak harddisk,  
dimana  informasi  tersebut  sangat  bermanfaat  untuk  meyakinkan  kita  bahwa  harddisk  yang  akan 
dioperasikan adalah benar harddisk yang dimaksud.

gambar 23: Menu Edit GParted

gambar 24: Menu View GParted



Operations  (gambar  26):  Pada bagian  paling  bawah jendela  GParted  akan muncul  baris-baris  perintah 
operasi yang belum dilaksanakan. Panel ini sangat bermanfaat untuk mengetahui seberapa banyak operasi 
yang akan dijalankan.

Kemudian pada menu Device, gambar  27, kita dapat memberikan label pada Disk (gambar  28). Apabila 
label yang terdapat dalam harddisk dirasa kurang tepat, kita dapat mengubahnya melalui menu ini.

gambar 25: Panel Informasi Harddisk

gambar 27: Tampilan Menu Device GParted

gambar 26: Panel untuk melihat proses operasi



Kemudian selanjutnya menu Partition (gambar 10)merupakan menu yang paling penting. Dari menu ini kita  
dapat melakukan banyak sekali operasi, yang bahkan beberapa diantaranya cukup berbahaya. Menu Delete 
dipakai jika ingin menghapus partisi. Untuk menghapus partisi kita diharuskan memilih partisinya terlebih 
dahulu. Untuk menu Resize/Move nanti akan dibahas secara terpisah. 

Dengan Gparted kita juga bisa langsung melakukan format partisi menjadi filesystem yang didukung oleh 
Gparted di menu tersebut. 

gambar 28: Memberikan label pada harddisk

gambar 29: menu partition



Kemudian pada pilihan yang paling bawah untuk memberikan penjelasan mengenai partisi yang dipilih.

Dan.. kemudian jika anda pilih menu Help, anda tidak menemukan apa-apa disana, soalnya memang belum 
diimpelementasikan.

➔ Operasi di Gparted

Membuat Partisi baru

Di dalam toolbar, ada tombol New yang berfungsi untuk membuat partisi baru. Dan tombol ini dapat  
aktif jika kita telah menyeleksi area yang belum ada partisinya atau unallocated area. 

gambar 30: Menentukan partisi

gambar 31: Informasi lengkap dari partisi



Kemudian jendela baru muncul dan kita dapat memilih ukuran terserah yang kita inginkan, sebagai 
primary, extended, ataupun logical (gambar 33), dan juga filesystem yang hendak digunakan (gambar 
34). 

Menghapus partisi

Pada icon kedua, digunakan untuk menghapus partisi (gambar 35). 

gambar 32: Tampilan awal GParted

gambar 33: Memilih jenis partisi

gambar 34: Memilih filesystem yang digunakan



Jika kita salah menghapus partisi yang tidak semestinya, segeralah mengklik undo (gambar 36), kalau 
tidak seluruh data di partisi tersebut akan hilang seperti asap. Tapi, jika anda yakin dengan yang anda  
lakukan, ya.. silahkan klik apply saja. Tapi mohon diingat, kalau sudah ditekan apply, jangan harap 
proses delete-nya bisa di undo.

Me-resize partisi

Jika ingin ukuran partisi untuk diubah, dapat dengan mengklik tombol Resize/Move, dan kemudian 
sebuah jendela akan muncul.  Gunakan mouse untuk mengurangi atau menambah partisi  dengan 
menggeret balok paritisnya (tanda atas) atau bisa juga dengan menuliskan ukurannya (tanda bawah) 
(gambar 38).

gambar 35: Icon di toolbar untuk menghapus partisi

gambar 36: Icon Undo pada toolbar



Menyalin Partisi

Mari kita lihat di fungsi bagian copy. Untuk mengaktifkannya, silahkan pilih partisi yang ingin dicopy 
(gambar 39). 

Setelah partisi dicopy, kita selanjutnya memilih area yang belum ada partisinya untuk mengaktifkan 
tombol  paste  (gambar  40).  

gambar 37: Icon Resize/Move pada toolbar

gambar 38: Mengubah ukuran partisi

gambar 39: Icon Copy di toolbar



Selanjutnya kita dapat menentukan ukuran partisi yang sudah di paste tadi, ingin ukurannya sama 
atau lebih besar (gambar 41). Tapi sayangnya tidak bisa lebih kecil.

Setelah itu, kita dapat mengklik undo atau apply untuk menerepkan pengubahan yang anda yakini.  
Selanjutnya kita akan ditanyai untuk yang terakhir (gambar 42)

Dan tentu saja anda dapat membatalkan proses yang sedang berjalan, tapi berhati-hatilah, proses 
pembatalan ini dapat merusak filesystem kita.

gambar 40: Icon Paste di toolbar pada area tanpa partisi

gambar 41: Mengatur ukuran partisi yang disalin

gambar 42: Jendela Pengingat untuk mengamankan 
data yang ada



Tips dan trik..

Pada pojok kanan atas, jika kita mengklik tanda panah yang ditandai lingkaran (gambar 25), kita akan 
dapat melihat beberapa daftar harddisk (gambar 43) (jika menggunakan harddisk lebih dari satu) dan 
pilih salah satu yang ingin dioperasikan, 

Jika kita ingin mengoperasikan pada partisi yang sedang di-mount, kita harus meng-umount partisi itu 
terlebih  dahulu.  Jika  partisi  tersebut  masih  ke-mount,  maka  tanda  gembok  coklat  akan  muncul 
disamping  tulisan  partisinya.  Untuk  menghilangkan  gemboknya,  makanya  perlu  di  umount 
dahulu(gambar 45).

gambar 43: Memilih harddisk dengan cepat

gambar 44: Menu multi harddisk



Jika sudah diumount maka pilihan operasi yang lain (gambar 46) juga akan tersedia. 

Menonaktifkan  swap  file  sebenarnya  tidak  perlu  dilakukan.  Tetapi  jika  proses  modifikasi  yang 
dilakukan  yaitu  pada  partisi  swap-nya,  baru  kita  perlu  menonaktifkan  dengan  mengklik  'swapoff'  
(gambar 47). 

gambar 45: Melakukan unmount partisi yang tergembok

gambar 46: Menu setelah di unmount



Untuk menutup Gparted,  seperti  aplikasi  lainnya, cukup tutup window-nya dengan mengkliknya di 
ujung kanan atas.

Instalasi Ubuntu
Di Linux Ubuntu, cara instalasi bisa menggunakan 2 cara yaitu instalasi modus grafis, dan instalasi modus 
teks. Di kedua cara ini sama-sama menawarkan cara mudah untuk instalasi, bedanya hanya pada modus 
yang digunakan saja. Pada modus grafis menggunakan GUI yang sangat mudah digunakan, sedangkan 
pada modus teks berupa teks mode namun ini tidak serumit seperti menggunakan konsole. 

➔ Instalasi Ubuntu Modus Grafis
Proses instalasi Ubuntu Modus Grafis sangatlah mudah, cukup dengan mengikuti beberapa langkah, Ubuntu 
dengan mudah terinstal di PC anda, langkah-langkah instalasinya sebagai berikut :

Mengawali Proses Boot Installasi

• Pertama pilihlah bahasa ((default English) dan tekan "Enter".

• Pilih "Install Ubuntu" dan tekan "Enter".

• Boot installer sedang berjalan.

gambar 47: Menonaktifkan swap



Pengenalakan lokal sistem anda

• Pilih bahasa yang ingin digunakan untuk sistem operasi (default English).

• Pilih zona waktu berdasarkan lokasi anda (Indonesia, Jakarta).

• Pilih keyboard layout yang digunakan (default English).

Pengaturan HardDisk dan Partisi

• Pilih  bagaimana Anda ingin  me-partisi  hardisk.  Ada  2  pilihan; Guided  –  Use entire hardisk 
digunakan menggunakan seluruh hardisk, seluruh data yang ada akan dihapus, atau gunakan 
Manual,  gunakan  partisi  hardisk  tertentu  yang  diinginkan.  

Untuk pemilihan penentuan partisi secara Manual, pilih seperti pada tampilan berikut. 

• Setelah  pemilihan  opsi  manual,  akan  terlihat  daftar  kondisi  hardisk,  

jika  hardisk  masih  kosong,  maka  tidak  terlihat  daftar  apapun.  
 Jika  hardisk  sebelumnya  terdapat  partisi  lain,  maka  partisi  tersebut  akan  ditampilkan.
 Untuk memulai mengatur partisi, klik tombol New Partition Table.

gambar 48: partisi baru

• Dengan  mengklik  tombol  New  Partition  Table,  akan  muncul  jendela  peringatan  perihal  

pengaturan seluruh partisi dalam hardisk. Abaikan saja pilihan ini dan pilih Continue.



gambar 49: partisi kosong

• Selanjutnya akan tertampil partisi yang yang masih kosong beserta dengan ukurannya. Klik New 
Partition untuk memulai  membuat partisi  baru.  Tampilan dasar pada pembuatan partisi  baru 
tertampil sebagai berikut.

gambar 50: membuat partisi baru

• Buat  partisi  awal,  sekitar  5GB  yang  nanti  akan  digunakanan  untuk  sistem  dasar.  

Jangan  lupa  tentukan  'Mount  Point'  di  '/'  (baca:  root).  
 Yang utama pada pembuatan partisi adalah tipe partisi (ReiserFS), ukuran partisi (5000MB), dan 
mount point-nya (/).



gambar 51: partisi root

gambar 52: contoh partisi root

• Kemudian buat partisi selanjutnya sebesar 5GB dan berikan mount point-nya sebagai  /home. 
Partisi ini akan menyimpan mayoritas data-data yang dibuat oleh pengguna.

gambar 53: membuat partisi home



gambar 54: membuat partisi swap

• Selanjutnya  buat  partisi  swap.  Swap  ini  digunakan  sebagai  virtual  memori.  

Jadi jika memori utama penuh atau tidak muat, luapannya akan di letakkan di virtual memori/swap. 
 Ukuran Swap untuk komputer saat ini dapat diperhitungkan total Swap ditambah RAM kurang lebih 
1,5 GB. Jadi apabila ram yang digunakan adalah 512MB, maka Swap dapat diberi ukuran sebesar 
1GB.  Jika komputer  digunakan untuk kinerja yang membutuhkan banyak membuka aplikasi,  atau 
mengaktifkan fungsi desktop effect 3D, ada baiknya untuk total Swap dan RAM kurang lebih sebesar 
2GB. Pengaturan swap seperti ditunjukkan pada gambar dibawah.

gambar 55: mempersiapkan partisi swap

• Penyusunan partisi yang telah selesai tertampil seperti pada tampilan berikut berikut.



gambar 56: tabel partisi yang telah jadi

Pengaturan User dan Password

• Ketik nama User anda (boleh asli boleh samaran), kemudian masukkan nama yang ingin anda 
gunakan untuk Login, dan isikan Password. selanjutnya klik forward.

• Tampilan selanjutnya adalah jendela informasi  setting instalasi.  Selanjutnya klik  Install untuk 
memulai proses instalasi.

•

gambar 57: nama user baru



Proses Installasi

• Selanjutnya harddisk akan dipartisi ulang dan system Ubuntu akan di install ke hardisk. Proses ini  
akan memakan waktu beberapa menit (30-45 menit).

• Setelah proses instalasi, maka akan keluar dialog instalasi telah komplit, dan anda dimintai untuk 
me-restart sistem. Klik Restart now

gambar 58: siap install

gambar 59: proses instalasi



 

• Setelah Sytem live CD mati, pada proses akhirnya, anda melihat dialog "press enter to continue", 
terlebih dahulu keluarkan CD Ubuntunya kemudian tekan Enter agar PC melakukan restart.

Hasil Installasi

• Selanjutnya boot ulang dan masuki sistem Ubuntu baru pada PC anda. Sistem Ubuntu anda 
telah mulai. Login ke desktop anda menggunakan username dan password yang telah dibuat 
sebelumnya. Tampilan Desktop Ubuntu 8.10 Intrepid Ibex.

gambar 60: restart setelah install

gambar 61: keluarkan cd instalasi



➔ Instalasi Ubuntu Modus Text
Pada prinsipnya, installasi Ubuntu pada modus text memiliki step-step yang sama dengan installsi modus 
grafis.  Installasi  modus teks ini  digunakan agar sistem tidak terlalu terbebani untuk menjalankan proses 
grafisnya.

Persiapan masuk ke Installasi

• Boot  Ubuntu  Alternate  tersebut  melalui  CD,  pada  layar  pilihan  boot,  pilih  bahasa  (default 
English). 

 

• pilih menu Install Ubuntu.

gambar 63: memilih bahasa

gambar 62: hasil instalasi default



Pengenalan Lokal Sistem

• Pilih bahasa yang ingin digunakan untuk sistem operasi (default English).

 

• Pilih region Other.

 

• Pilih benua Asia. 

gambar 64: pilih install ubuntu

gambar 65: pilih bahasa instalasi

gambar 66: memilih daerah waktu



 

• Kemudian pilih Indonesia.

 

• Pada saat proses pendeteksian keyboard, jika keyboard yang digunakan adalah keyboard biasa, 
pilihlah No.

gambar 67: pilih Asia

gambar 68: pilih Indonesia



Menu selanjutkan akan diminta memasukkan jenis keyboard yang digunakan.  

• Pilih keyboard USA (default)

 

 

• Tunggu sejenak untuk masuk ke proses berikutnya

Pengaturan jaringan pra installasi

• System akan mencoba dahulu, apakah jaringan yang saat ini digunakan pada mode DHCP atau 
bukan. Jika yakin tidak pada mode DHCP, silahkan tekan Cancel (Tombol Enter)  

gambar 69: Jangan auto Detect!

gambar 70: pilih keyboard USA



• Pesan yang diberikan jika server DHCP tidak ditemukan.

 

• Opsi yang diberikan untuk mengatur konfigurasi  jaringan. Ada baiknya konfigurasi  di  lakukan 
setelah sistem terinstall. Oleh karena itu pilih Do not configure the network at this time 

gambar 71: pilih cancel agar tidak dhcp

gambar 72: dhcp failed!



 

• Berikan hostname komputer sesuai dengan yang anda inginkan.

Pengaturan Zona Waktu

• Pilih kota yang berada pada Zona Waktu anda sekarang. Jika anda berada di Waktu Indonesia 
Barat, silahkan pilih Jakarta 

gambar 73: tidak perlu konfigurasi network

gambar 74: berikan hostname



gambar 75: memilih zona waktu

Pengaturan Harddisk dan Partisi

• Pilih bagaimana Anda ingin me-partisi hardisk. Ada 5 pilihan; 

1. Guided – use entire disk, digunakan menggunakan seluruh hardisk, seluruh data yang ada 
akan dihapus.

2. Guided – use the largest continuous free space, digunakan menggunakan space sisa yang 
berurutan di harddisk

3. Guided – use entire hardisk and Set Up LVM. menggunakan seluruh space dan buat partisi 
baru diatas LVM. Seluruh data yang ada akan dihapus.

4. Guided – use entire hardisk and Set Up encrypted LVM. Mirip dengan opsi sebelumnya 
hanya saja LVM yang digunakan terenkripsi.

5. Manual, gunakan partisi hardisk tertentu yang diinginkan. 

 

• Untuk pemilihan penentuan partisi kita akan menggunakan secara  Manual, terlihat free space 
pada partisi. Pilih Free Space tersebut kemudian tekan Enter.

gambar 76: partisi manual



• Langkah selanjutnya memulai proses partisi. Pilih  Create new partition untuk membuat partisi 
primary untuk root (/) dan ukuran partisi sebesar 5GB dengan format system EXT3.

gambar 77: pilih partisi kosong

gambar 78: buat partisi baru

gambar 79: membuat partisi root



gambar 80: pilih tipe primary

gambar 81: lokasi posisi partisi



• Langkah berikutnya kurang lebih sama dengan langkah sebelumnya, hanya saja saat ini untuk 
partisi  home. Pilih  FREE SPACE, kemudian pilih  Create new partition untuk membuat partisi 
logical dan ukuran partisi sebesar 5GB dengan format system EXT3.

gambar 82: selesai pilih done

gambar 83: membuat partisi home

gambar 84: membuat partisi baru



• Lakukan proses selanjutnya untuk partisi Swap

gambar 85: memilih tipe logical

gambar 86:Selesai, pilih done

gambar 87: memilih partisi untuk swap



• Jika sudah selesai, pilih Finish partitioning and write changes to disk

 

• Pada proses terakhir  mempartisi,  akan muncul  kotak verifikasi  akhir  untuk konfirmasi apakah 
yakin pembagian partisi sudah benar. Pilih Yes untuk melanjutkan ke tahap selanjutnya. Pilih No 
untuk kembali mem-partisi. Pilihlah Yes.

gambar 88: ukuran swap area tidak perlu terlalu besargambar 89: sukses membuat swap area

gambar 90: terakhir pilih finish

gambar 91: preview dan verifikasi akhir



Proses Installasi Sistem Dasar

• Proses pengaturan partisi diterapkan ke dalam harddisk. Tunggulah beberapa saat, sistem dasar 
sedang di muat.

Pengaturan User dan Password

• Masukkan nama anda sebagai informasi user pada ubuntu.

 

• Secara otomatis, ubuntu akan memilihkan username yang di parsing dari Nama Anda. Jika anda 
memilih untuk menggunakan username yang lain, silahkan diubah. 

• Berikan password untuk username yang anda gunakan 

• Masukkan password sekali lagi untuk verfikasi password anda 

• Anda akan ditanyakan, apakah data-data anda ingin dibuat sangat privasi  atau tidak.  Secara 
default, anda dapat memilih No

gambar 92: instalasi base system

gambar 93: membuat user dan password



Proses Installasi

• Silahkan tunggu proses Installasi ini sekitar 30 hingga 50 menit

 

• Jika jam pada BIOS dan jam pada sistem berbeda, anda dapat memilih Yes. Jika anda ingin jam 
pada sistem Ubuntu sama dengan jam pada BIOS, maka pilihlah No. Dalam hal ini, pilihlah No 

gambar 94: pilih no untuk encrypted password

gambar 95: proses instalasi dimulai

gambar 96: pilih no untuk penyesuaian jam



• Installasi selesai. Pilih Continue untuk merestart dan masuk ke sistem terinstall.

Hasil Installasi

 Instalasi Ubuntu Pada Flash Drive
Panduan ini menunjukkan bagaimana Anda dapat menginstal Ubuntu 8,10 pada USB flash drive. Ubuntu 
8,10 dilengkapi dengan tool yang digunakan untuk membuat USB startup disk dengan mudah. Startup disk 
ini akan seperti anda menjalankan Ubuntu 8,10 Live-CD. Ini berguna jika anda ingin menginstal Ubuntu pada 
komputer yang tidak memiliki CD / DVD drive. Bila membuat USB startup disk, Anda juga dapat menentukan 
bahwa anda ingin sistem USB untuk tetap ketika boot (yaitu tidak kehilangan pengaturan, dokumen, dll). 
Dengan cara ini Anda mendapatkan yang benar-benar bermanfaat, OS yang dapat bawa ke dalam saku 
baju Anda. 

➔ Membuat USB Startup Disk
1. Boot kedalam normal sistem Ubuntu 8.10. Setelah masuk kedalam Desktop, colokkan USB flash drive 

dan masukkan Ubuntu 8.10 Live-CD kedalam CD drive (anda juga dapat membuat startup disk dari  
file iso buntu 8.10 Live-CD, tergantung mana yang anda pilih);

2. Kemudian klik menu System  → Administration  → Create a USB startup disk… ;

gambar 97: hasil instalasi 1

gambar 98: hasil instalasi 2



3. Ketikkan password user anda

4. Setelah USB Startup Disk tool jalan. Pastikan pilihan yang benar untuk sumber CD dan target USB 
drive secara automatis (jika ingin menggunakan file iso Ubuntu 8.10, klik di tombol Other… dan pilih 
file iso-nya). Jika anda ingin membuat sebuah USB startup disk yang anda butuhkan untuk instalasi  
Ubuntu 8.10 di sistem tanpa sebuah CD/DVD drive, pilih "Discarded on shutdown, unless you save 
them elsewhere" startup disk akan seperti Live-CD, yaitu semua dokumen dan setting akan hilang 
jika reboot. Jika Anda ingin memiliki "penuh" OS yang menyimpan perubahan Anda dan reboot antara 
yang dapat  membawa Anda di  dalam saku,  pilih  Stored in  reserved extra space dan tentukan 
berapa banyak space pada flash drive USB yang akan digunakan untuk dokumen dan setting. Klik  
tombol Make Startup Disk untuk melanjutkan :

gambar 99: menu create usb startup

gambar 100: masukkan password untuk  
sudo

gambar 101: menentukan space



5. USB startup disk dalam proses pembuatan dan akan memakan waktu beberapa menit;

6. Klik tombol Quit untuk menyelesaikan proses;

7. Dan Flash Drive siap digunakan sebagai Live USB Ubuntu.

➔ Booting dari USB Flash Drive
1. Sekarang anda colokkan USB flash drive kedalam komputer anda dan nyalakan. Pastikan bahwa 

anda masuk kedalam BIOS dan cek bahwa booting dari  USB sudah di  enable-kandan dan USB 
device adalah first device boot order pada BIOS;

2. Ketika sistem boot dari USB flash drive, maka akan seperti jika kita boot dari Ubuntu 8.10 Live-CD,  
pertama anda akan dihadapkan pilihan untuk memilih bahasa yang akan digunakan :

3. Dalam boot menu, pilih Try Ubuntu without any change to your computer (jika anda ingin install 
ubuntu kedalam sistem, anda juga dapat secara langsung memilih Install Ubuntu;

gambar 102: proses pembuatan

gambar 103: selesai tekan quit

gambar 104: test booting via usb drive



4. Kemudian desktop Ubuntu siap di nikmati. Jika anda ingin meng-install Ubuntu kedalam hardisk, klik 
icon shortcut Install dan ikuti petunjuk instalasi.

Konfigurasi Bootloader
Bootloader  yang  umum  dipakai  di  linux  adalah  LILO  dab  GRUB  (Grand  Unified  Bootloader).  Ubuntu 
memakai GRUB untuk bootloadernya. Salah satu fungsi bootloader adalah untuk memilih sistem operasi 
yang kita ingin untuk di  boot. Bootloader tersebut dapat dilakukan konfigurasi dan kostumisasi agar dapat 
lebih menarik dilihat.

➔ StartUp-Manager
Salah satu aplikasi yang digunakan untuk mengkonfigurasi dan mengkostumasi bootloader di ubuntu adalah 
startup manager. Untuk instalasinya melalui  Add/Remove Application yang terdapat di  Applications → 
Add/Remove,  StartUp-Manager  terdapat  di  bagian  System  Tools atau  dapat  menggunakan  fasilitas 
pencarian di Add/Remove Application.

Setelah  instalasi,  StartUp-Manager  dapat  diakses  di  System   Administration   StartUp-Manager→ → . 
Terdapat beberapa bagian di StartUp-Manager yaitu Boot options, Appereance, Security, Advanced.

Pada bagian Boot options terdapat opsi untuk mengatur konfigurasi dari bootloader seperti waktu tunggu,  
dan sistem operasi default yang akan dipakai.

gambar 105: jalankan live system via usb

gambar 106: system live usb siap digunakan



Untuk mengkostumasi tampilan dari bootloader ubuntu terdapat di bagian Appearance. Disini terdapat opsi  
untuk mengganti warna yang terdapat di menu bootloader. Selain itu di bagian ini dapat juga mengganti  
gambar latar untuk bootloader dan juga dapat mengganti tema splash screen yang dapat memakai usplash 
atau splashy.

Bootloader juga dapat dikonfigurasi agar dapat memakai kata sandi ketika akan menggunakan salah satu 
pilihan yang terdaftar di bootloader.

gambar 107: jendela start manager

gambar 108: appereance login manager



Pada bagian Advanced terdapat konfigurasi untuk rescue mode dan rescue floppy.

Menambah dan Menghapus Aplikasi
Menambahkan paket aplikasi di Ubuntu sangatlah mudah. Ada 2 aplikasi grafis yang umum digunakan yaitu 
Add/Remove Application dan Synaptic Package Manager. Kedua aplikasi ini memiliki fungsionalitas yang 
sama. Namun kedua aplikasi ini melakukan proses instalasi melalui koneksi internet. Sementara untuk yang 
tidak memiliki koneksi internet bisa menggunakan DVD Repo atau apt-web.

Konfigurasi setelah instalasi
Sebelum melakukan instalasi  ada baiknya anda melakukan sedikit  konfigurasi,  untuk menset  repository 
(gudang aplikasi) di Ubuntu. Berikut langkah-langkahnya :

• Tekan Alt+F2

• Ketik "gksu gedit /etc/apt/sources.list" (tanpa tanda petik)

gambar 109: security login manager

gambar 110:setting advance



• Masukkan password anda

• Kemudian anda akan mendapatkan tampilan seperti berikut :

• Hapus semua isi dalam file tersebut, kemudian ganti dengan berikut:

deb http://repo.ugm.ac.id/ubuntu/ intrepid main restricted universe multiverse
deb http://repo.ugm.ac.id/ubuntu/ intrepid-updates main restricted universe multiverse
deb http://repo.ugm.ac.id/ubuntu/ intrepid-security main restricted universe multiverse
• Save kembali dengan menekan tombol Ctrl+S

Menambahkan dan menghapus aplikasi

➔ Add/Remove
Untuk aplikasi Add/Remove bisa anda temukan di Application  Add/Remove→

Aplikasi di Ubuntu terpisah menjadi group-group seperti Accessories, Education, Games, Graphics, Internet, 
Office, Other, Programming, Sound & Video, System Tools, dan Universal Access. Pembagian group ini 
akan memberikan kemudahan dalam mencari aplikasi. Misalkan anda mencari aplikasi pemutar video, anda 
dapat menemukannya di group Sound & Video.

Langkah-langkah instalasi aplikasi melalui add/remove

• Pada bagian show, anda dapat mengganti menjadi "All Available Applications" sehingga dapat 

gambar 111: edit source.list
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menampilkan seluruh aplikasi yang tersedia di repository (gudang aplikasi).

 

• Search, digunakan untuk mencari  aplikasi  yang anda butuhkan. Misalkan anda ingin mencari 
pemutar video , anda cukup pilih group Sound & Video, kemudian masukkan kata kunci di bagian  
search.

• Beri tanda cek pada aplikasi yang akan anda install

• Kemudian  akan  muncul  tampilan  yang  memberikan  informasi  bahwa  instalasi  aplikasi 
membutuhkan koneksi internet. Disini anda cukup klik enable

• Kemudian klik Apply Changes

gambar 113: memilih kategori  
aplikasi

gambar 114: memilih paket yang akan diinstall

gambar 115: konfirmasi aktivasi jaringan



• Sekarang tinggal menunggu proses instalasi

• Selesai instalasi aplikasi

➔ Synaptic Package Manager
Synantic Package Manager sebenarnya sama saja dengan add/remove, namun penggunaan aplikasi  ini 
lebih  advance  dari  add/remove.  Menggunakan Synaptic  anda  dapat  melakukan  perubahan  repositories 
(gudang aplikasi),  penambahan proxy,  dan  informasi  aplikasi  yang  lebih  lengkap.  Synaptic  dapat  anda 
temukan di System  Administration  Synaptic Package Manager→ →

gambar 116: menerapkan aplikasi yang akan diinstall
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Penggunaan Synaptic

Pada pembahasan  sebelumnya,  saya  sempat  melakukan konfigurasi  manual  untuk  repository,  di 
Synaptic anda juga dapat melakukan perubahan konfigurasi tersebut. 

Ubuntu  menggunakan  sistem  paket  repository  untuk  menambah  atau  membuang  aplikasi  yang 
diinginkan. User interface yang digunakan biasanya Synaptic (GUI) atau perintah apt-get (CLI).

Mengubah Daftar Repository Melalui File

Untuk  menambahkan/mengganti  daftar  repository  baru  anda  bisa  melakukannya  dengan  sangat 
mudah,  yang  diperlukan  cukup  sebuah  file  dengan  nama  sources.list.  Berikut  langkah-langkah 
membuat file sources.list

Buka text editor di  Applications  Accessories  Text Editor→ →  - Tambahkan baris seperti  pada 
gambar dibawah, kemudian disimpan dengan nama file sources.list

Pada file manager, klik ganda file source.list yang telah anda buat sebelumnya 

gambar 119: synaptic paket manager
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Ketika anda mengeksekusi file sources.list tersebut, otomatis akan diminta memasukkan password 
administrator (sudo), isikan dengan password yang anda miliki - Selanjutnya akan muncul jendela 
dialog,  apakah  kita  akan  menukar  konfigurasi  sources.list  yang  lama  (Replace)  atau  cukup 
menambahkan  daftar  repository  saja  (Add).  Pada  contoh  klik  saja  replace,  karena  kita  tidak 
membutuhkan daftar repository yang lama

Terakhir  muncul  jendela  dialog  untuk  mereload  ulang  daftar  repostory  yang  baru.  Klik  Reload, 
kemudian Close. Repository yang baru siap digunakan

gambar 121: klik ganda file sources.list
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yang baru
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Mengubah Daftar Repository Cara Lama

Untuk mengubah daftar repository di synaptic yaitu melalui menu  Settings –> Repositories pada 
Synaptic  
 kemudian anda akan menemukan jendela konfigurasi repository seperti gambar berikut ;

Kemudian Klik tombol Add untuk menambahkan, kemudian isikan baris berikut satu persatu: 

deb http://repo.ugm.ac.id/ubuntu/ intrepid main multiverse restricted universe

deb http://repo.ugm.ac.id/ubuntu/ intrepid-updates main multiverse restricted universe

deb http://repo.ugm.ac.id/ubuntu/ intrepid-security main multiverse restricted universe

Anda juga dapat menambahkan daftar repository multimedia medibuntu; 

deb http://repo.ugm.ac.id/medibuntu/ intrepid free non-free

deb http://repo.ugm.ac.id/medibuntu/ intrepid-staging free non-free

Kemudian tekan tombol Add Source untuk melanjutkan. Agar sistem menggunakan konfigurasi yang 
baru  
 maka lakukan Reload terlebih dahulu dengan menekan tombol Reload pada Synaptic.

Mencari Aplikasi

Fitur search Application pada Intrepid sangat mudah digunakan. Tidak seperti versi sebelumnya yang 
harus melalui menu Edit  Search→ . Kolom search sudah tersedia pada toolbar bagian atas. Cukup 
dengan  mengetikkan  kata  kunci  jenis  aplikasi  yang  kita  inginkan,  selanjutnya  system  akan 
menampilkan beberapa aplikasi yang sesuai dengan kata kunci tersebut. Perhatikan gambar dibawah. 

gambar 124: menambahkan atau mengubah dengan cara lama



Untuk  pencarian  yang  lebih  detil,  anda  dapat  mengklik  tombol  search  disamping  kolom  search 
tersebut. Selanjutnya akan muncul kotak search untuk model pecarian aplikasi berdasarkan kategori 
yang lebih detil.

Install Aplikasi

Untuk menginstall suatu aplikasi anda dapat melakukanya dengan memilih daftar paket aplikasi yang 
akan  diinstall,  untuk  memudahkan  dalam  proses  instalasi  anda  dapat  menggunakan  fasilitas 
pencarian paket seperti yang telah dijelaskan sebelumnya

Untuk menginstallnya maka klik kanan pada nama aplikasi tersebut dan pilih Mark for installation

Kemudian apabila aplikasi  yang akan anda install  memiliki  ketergantungan (dependensi)  terhadap 
aplikasi lain maka sistem akan menanyakan apakah kita akan melanjutkan dan mengikut sertakan 
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aplikasi  pelengkap tersebut,  untuk  melanjutkan  tekan saja  menu  Mark,  kemudian untuk  memulai 
proses instalasi tekan tombol Apply.

Menghapus Aplikasi

Untuk menghapus aplikasi langkah yang digunakan hampir sama dengan langkah ketika kita akan 
menginstall  aplikasi,  pada synaptic pilih  aplikasi  yang akna kita hapus kemudian klik  kanan pada 
nama aplikasi dan pilih menu mark for Complete removal

kemudian klik Apply untuk menghapus aplikasi yang telah kita tandai untuk di hapus.
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Menggunakan Save Marking

Di Synaptic terdapat fasilitas Save Markings yang fungsinya untuk menyimpan daftar aplikasi-aplikasi 
yang kita tandai untuk di install, untuk menggunakanya pada jendela synaptic pilih menu File –> Save 
Markings As

 

Untuk menggunakanya klik menu  File –> Read Markings dan pilih file marking yang sebelumnya 
anda simpan kemudian tekan Open, maka anda akan menemukan daftar aplikasi yang sebelumnya 
anda simpan.

Update System

Untuk  melakukan  update  sistem kita  kita  dapat  menggunakan  tool  Update  Manager yang  telah 
disediakan oleh Ubuntu, untuk melakukannya klik pada Start Menu  System –> Administration –> 
Update Manager
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maka setelah itu akan muncul jendela Update Manager seperti tampilan berikut.

 
kemudian untuk mengupdate aplikasi, pilih aplikasi yang akan kita update dengan mengisi check box 
aplikasinya kemudian tekan Install Updates

Instalasi Program (Modus Teks)

Bila pada modus grafis penambahan program pada ubuntu dilakukan dengan aplikasi synaptic, maka 
pada  modus  teks  penambahan  dan  pengurangan  program  dilakukan  dengan  perintah  apt-get. 
Sebelum melakukan penginstallan program terlebih dahulu men-set repository yang digunakan untuk 
penginstallan. Untuk distro ubuntu, UGM telah membuat mirror repository yang berada pada alamat 
http://repo.ugm.ac.id/ubuntu/. Karena itu tambahkan repository ubuntu yang terdapat di UGM terlebih 
dahulu pada daftar repository. Untuk menambahkannya edit file sources.list di direktori /etc/apt/.

$ sudo vim /etc/apt/sources.list

Repository  UGM  berada  pada  alamat  http://repo.ugm.ac.id/ubuntu/ dapat  ditambahkan  pada  file 
sources.list : 
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deb http://repo.ugm.ac.id/ubuntu/ intrepid main multiverse restricted universe
deb http://repo.ugm.ac.id/ubuntu/ intrepid-updates main multiverse restricted universe
deb http://repo.ugm.ac.id/ubuntu/ intrepid-security main multiverse restricted universe

Intrepid pada akhir alamat url adalah nama kode dari Ubuntu 8.10, setiap rilis ubuntu juga terdapat 
kode  nama  yang  berbeda-beda  seperti  5.10  adalah  breezy.  Untuk  hardy-updates dan  hardy-
security biasanya berupa update untuk hardy. Perlu diingat bahwa setelah alamat semua kata harus 
dipisahkan spasi.

Setelah  menambahkan  repository,  terlebih  dahulu  melakukan  update  agar  terjadi  sinkronisasi 
informasi  paket  yang  terdapat  di  repository  dengan  komputer.  Update  sebaiknya  tidak  hanya 
dilakukan setelah menambah repository saja tetapi dapat dilakukan secara berkala. 

$ sudo apt-get update

Contoh Install Program xmms

Setelah  melakukan  update  maka  bisa  dilanjutkan  dengan  menginstall  program yang  dibutuhkan. 
sebagai contoh jika akan menginstall xmms maka menggunakan perintah : 

$ sudo apt-get install xmms

Maka akan muncul keterangan tentang instalasi : 

Reading package lists... Done 
Building dependency tree       
Reading state information... Done 
The following packages were automatically installed and are no longer required: 
  cdda2wav libpcrecpp0 ogmtools icedax sox mjpegtools mkvtoolnix 
Use 'apt-get autoremove' to remove them. 
The following NEW packages will be installed: 
  xmms 
0 upgraded, 1 newly installed, 0 to remove and 76 not upgraded. 
Need to get 813kB of archives. 
After unpacking 6455kB of additional disk space will be used. 
Get:1 http://repo.ugm.ac.id feisty/main xmms 1:1.2.10+20061201-1ubuntu3 [813kB] 
Fetched 813kB in 0s (3651kB/s) 
Selecting previously deselected package xmms. 
(Reading database ... 151191 files and directories currently installed.) 
Unpacking xmms (from .../xmms_1%3a1.2.10+20061201-1ubuntu3_i386.deb) ... 
Setting up xmms (1.2.10+20061201-1ubuntu3) ... 

Jika dalam menginstall suatu program di butuhkan paket tambahan lainnya (bisa disebut dependensi),  
maka apt akan otomatis mencarinya dan diinstall juga.

Selain  untuk  menginstall  program,  apt  juga  bisa  digunakan  untuk  meng-uninstall  program  yang 
terdapat  di  ubuntu.  
Sebagai contoh jika ingin menghapus xmms maka perintahnya : 

# sudo apt-get remove xmms

Sebelum penghapusan dilakukan maka akan ada konfirmasi terlebih dahulu : 

Reading package lists... Done 
Building dependency tree 
Reading state information... Done 
The following packages were automatically installed and are no longer required: 
 cdda2wav libpcrecpp0 ogmtools libmikmod2 icedax sox mjpegtools mkvtoolnix 
Use 'apt-get autoremove' to remove them. 
The following packages will be REMOVED: 
 xmms 
0 upgraded, 0 newly installed, 1 to remove and 76 not upgraded. 



Need to get 0B of archives. 
After unpacking 6455kB disk space will be freed. 
Do you want to continue [Y/n]? 
Jika penghapusan sudah selesai maka akan ada pemberitahuan :
(Reading database ... 151241 files and directories currently installed.) 
Removing xmms ... 

Aplikasi Multimedia

Audacious Audio Player
Audacious merupakan aplikasi audio player yang memiliki fungsi sama dengan winamp di Windows. Secara 
tampilan audacious sama dengan winamp, serta cara penggunaannya pun 95% sama.

➔ Instalasi
1. Buka aplikasi Synaptic Package Manager dengan meng-klik menu System –>  Administrations –> 

Synaptic Package Manager;

2. Search dengan keyword "audacious";

3. Klik kanan pada paket audacious dan pilih Mark For Installation dan klik tombol Apply;

4. Atau melalui terminal, dengan mengetikkan perintah berikut : $ sudo apt-get install audacious

➔ Penggunaan
Untuk menjalankan aplikasi audacious klik menu Applications  → Sound & Video  → Audacious.

gambar 134: mp3 player dengan audacious
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Secara default menu-menu player audacious sama dengan winamp. Saat aplikasi dijalankan anda hanya 
mendapati tampilan Player-nya saja, untuk menampilkan equalizer dan playlist silahkan anda merujuk pada 
table dibawah ini :

Gambar Keterangan 

 Klik icon ini untuk menampilkan equalizer 

 Klik icon ini untuk menampilkan playlist editor 

 Klik icon ini untuk melakukan repeat (memainkan kembali playlist)

➔ Menambahkan lagu
Pada playlist editor, klik Add  → Add files  Silahkan anda menentukan letak dan lagu yang anda inginkan.→

➔ Menghapus lagu
Pada playlist editor, Pilih lagu  Klik → SUB  → Remove Selected

➔ Menghapus playlist
Klik  SUB  → Remove  All.  Karena  semua  fungsional  aplikasi  ini  sama  dengan  winamp,  anda  dapat 
menggunakan fungsi-fungsi yang sama seperti saat anda menggunakan Winamp pada Windows.

➔ Mengganti Skin
1. Download  paket  skin  Winamp  Audacious  di  sini  (http://repo.ugm.ac.id/ekstra/.ugos_tools/14870-

Winamp5-XMMS.tar.bz2)

2. Klik kanan pada player audacious kemudian pilih menu preferences audacious, cukup klik kanan pada 
player.

gambar 136: audacious default
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3. Pada tab Appearance drag drop paket hasil download tadi kedalam kotak dialog skin. 

4. Setelah skin Winamp dipilih, klik tombol Close.
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Totem Movie Player
Totem Movie Player merupakan default  player video pada Ubuntu. Namun untuk menjalankan video file  
berformat avi atau mpeg harus menginstall beberapa codecs agar bisa memainkan file tersebut. 

➔ Instalasi Codecs
1. Buka aplikasi Synaptic Package Manager dengan meng-klik menu System –>  Administrations –> 

Synaptic Package Manager;

2. Search dengan keyword "gstreamer";

3. Klik  kanan pada  paket  gstreamer0.10-ffmpeg gstreamer0.10-pitfdll  gstreamer0.10-plugins-bad 
gstreamer0.10-plugins-bad-multiverse gstreamer0.10-plugins-ugly gstreamer0.10-plugins-ugly-
multiverse dan pilih Mark For Installation dan klik tombol Apply;

4. Atau melalui terminal, dengan mengetikkan perintah berikut : 

$ sudo apt-get install gstreamer0.10-ffmpeg gstreamer0.10-pitfdll gstreamer0.10-plugins-
bad gstreamer0.10-plugins-bad-multiverse gstreamer0.10-plugins-ugly gstreamer0.10-
plugins-ugly-multiverse

➔ Penggunaan
Untuk menjalankan aplikasi  Totem Movie Player klik menu  Applications  → Sound & Video  → Movie 
Player.

Mplayer Movie Player
Merupakan aplikasi alternative pilihan untuk memainkan file video di Ubuntu selain Totem Movie player yang 
merupakan bawaan default Ubuntu 8.10 Intrepid Ibex.

➔ Instalasi
1. Buka aplikasi  Synaptic Package Manager dengan meng-klik  menu System –> Administrations –> 

Synaptic Package Manager;

2. Search dengan keyword "mplayer";

3. Klik kanan pada paket  mplayer dan  mplayer-fonts, kemudian pilih  Mark For Installation dan klik 
tombol Apply;

gambar 141: jendela totem movie 



4. Atau melalui terminal, dengan mengetikkan perintah berikut : 

$ sudo apt-get install mplayer mplayer-fonts

➔ Penggunaan
Untuk menjalankan aplikasi mplayer klik menu Applications  → Sound & Video  → Mplayer Movie Player.

Memutar File Video

1. Klik kanan pada player  → Open  → Play File;

2. Cari file format Video semisal berekstensi .avi atau .mpeg;

gambar 142: jendela mplayer 
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3. Kemudian klik tombol OK.

Memutar VCD

1. Masukkan VCD video yang akan di tonton kedalam CD/DVD ROM tray;

2. Klik kanan pada player  → Open  → Play VCD.

Memutar DVD

1. Masukkan DVD video yang akan di tonton kedalam DVD ROM tray;

2. Klik kanan pada player  → Open  → Play DVD.

SMPlayer
Merupakan aplikasi alternatif front end dari aplikasi Mplayer, tampilan lebih user friendly dan navigasinya 
cukup mudah digunakan.

➔ Instalasi
1. Buka aplikasi Synaptic Package Manager dengan meng-klik menu System –>  Administrations –> 

Synaptic Package Manager;

2. Search dengan keyword "mplayer-nogui" dan "smplayer" ;

3. Klik kanan pada paket mplayer-nogui dan smplayer, kemudian pilih Mark For Installation dan klik 
tombol Apply;

4. Atau melalui terminal,  dengan mengetikkan perintah berikut :  $ sudo apt-get install  mplayer-nogui 
smplayer

➔ Penggunaan
Untuk menjalankan aplikasi audacious klik menu Applications  → Sound & Video  → SMPlayer.

gambar 145: memilih file video



Dibawah ini merupakan tabel tombol navigasi pada panel SMPlayer.

Gambar Keterangan 

 

tombol File (Ctrl+F) untuk memainkan file video didalam hardisk

 

tombol DVD from drive untuk memainkan DVD video

 

tombol URL (Ctrl+U) untuk memainkan file video dari alamat URL

 

tombol Compact Mode (Ctrl+C) untuk menampilkan layar secara compact

 

tombol Full Screen (F) untuk menampilkan layar secara penuh

 

tombol Screenshoot (S) untuk melakukan capture video menjadi gambar

 

tombol View info and Properties.. (Ctrl+i) untuk melihat info dan properties file video 

 
tombol Playlist (Ctrl+l) untuk menampilkan jendela Playlist

 

tombol Preferences (Ctrl+P) untuk menampilkan jendela setting SMPlayer

 

tombol Previous (<) untuk memainkan playlist sebelumnya 

 

tombol Next (>) untuk memainkan playlist berikutnya 

Cheese Webcam Booth
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Cheese  adalah  aplikasi  webcam  yang  terinspirasi  dari  aplikasi  GNOME  Photobooth  untuk  mengambil  
gambar dan video dari webcam. Cheese juga disertai efek grafis fancy berdasarkan gstreamer-backend.

➔ Instalasi
1. Buka aplikasi Synaptic Package Manager dengan meng-klik menu  System  → Administrations → 

Synaptic Package Manager;

2. Search dengan keyword "cheese";

3. Klik kanan pada paket cheese dan pilih Mark For Installation dan klik tombol Apply;

4. Atau melalui terminal, dengan mengetikkan perintah berikut : $ sudo apt-get install cheese

➔ Penggunaan

Capture Photo

1. Untuk menjalankan aplikasi cheese klik menu Applications  → Graphics  → Cheese Webcam 
Booth;

2. Klik tombol Take a photo;

gambar 148: logo 
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3. Untuk lokasi penyimpanan hasil capture di:

• Photo : document home Pictures/Webcam

• Video : document home Videos/Webcam

4. Jika anda ingin menyimpan kedalam media yang lain, klik kanan pada daftar capture photo pilih 
save as;

5. Menambahkan efek photo klik pada tombol  effect, dan pilih template efeknya kemudian klik 
tombol effect-nya kembali. 

gambar 150: mengambil foto
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Capture Video

1. Klik pada tombol Video, kemudian klik tombol Start Recording untuk memulai merekam video

2. Jika sudah selesai klik tombol Stop Recording

Konfigurasi

1. Klik Edit  → Preferences;

2. Pada preferences anda bisa mengkonfigurasi ;

• Camera, jika anda mempunyai lebih dari satu kamera webcam, opsi ini bisa digunakan.

• Resolution, digunakan untuk menentukan besaran pixel dalam meng-capture photo/video.
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CD/DVD Burning

➔ Brasero Disc Burning
Brasero adalah sebuah aplikasi  pembakar  CD dan DVD.  Sejak  Ubuntu 8.04,  aplikasi  ini  sudah secara 
default ter-install. Langkah Penggunaannya sebagai berikut :

1. Masukkan CD/DVD kosong kedalam disc tray;

2. Jalankan Brasero melalui menu Applications  → Sound & Video  → Brasero Disc Burning;

3. Ditampilan awal, Brasero memberikan empat jalan pintas untuk anda;

• Audio Project, ini digunakan untuk membuat CD/DVD dengan format audio (CDDA, not MP3) dari  
koleksi musik anda (mp3, ogg, dll - selama ada codec-nya!);

• Data Project, ini digunakan untuk mem-burning file apa saja sebagai data biasa, tanpa melakukan 
perubahan apapun;

• Video Project, ini digunakan untuk membuat CD/DVD dengan format video.

• Disc  Copy,gunakan ini  jika  anda ingin  membuat  copy  CD/DVD ke CD/DVD (identik)  atau  ke 
hardisk, sebagai file image (ISO);

• Burn Image,pilihan ini untuk mem-burning file image (ISO) ke CD/DVD.

4. Selain melalui tampilan awal, anda bisa mengakses menu ini melalui menu Project  → New Project;

gambar 156: jendela preferences
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5. Setelah anda memilih Data Project, anda akan mendapatkan jendela di bawah ini.

6. Jendela terbagi menjadi dua bagian. Bagian Project, tempat anda menampung file/direktori yang akan 
di burn dengan barometer kapasitas media dibawahnya.Seperti file manager, anda bisa;

• Membuat direktori baru, klik ikon new directory;

• Menghapus direktori/file, klik kanan  → remove;

• Memindah file/direktori, select  drag dan paste ke tujuan;→

• Mengganti nama, klik kanan  → rename;

• Dan sebagainya. Anda hanya perlu klik kanan, dan pilihan yang tersedia akan muncul;

• Jendela  kedua,  adalah  jendela  file  manager/browser.  Tampilannya  identik  dengan  nautilus 
dengan task/side pane-nya. Jika anda akan menambahkan direktori/file, select file/direktori yang 
anda inginkan lalu klik tanda plus (+) di task/menu bar.
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7. Melanjutkan Session,jika media yang anda gunakan memiliki session sebelumnya (belum di fixating), 
anda bisa melanjutkan menulis dengan memilih import session. Klik ikon import session;

8. Membakar CD/DVD, dengan meng-klik tombol Burn..;

9. Di jendela berikutnya, anda bisa:

• Memilih pembakar yang akan digunakan, CD/DVD writer atau Image. Pilih Image untuk membuat 
file iso;

• Mengganti nama disc dengan nama pilihan anda sendiri;

• Membuat/memulai multisession (jika belum ada).

10. Jika sudah membuat perubahan final, silahkan mengklik tombol Burn. Anda perlu menunggu sekitar 
10 menit dan CD anda telah siap digunakan.

gambar 160: tampilan data yang telah  dipilih

gambar 161: setup disk



➔ Burning image file iso dengan Nautilus
Untuk membakar file image (iso) selain menggunakan Brasero, anda juga dapat menggunakan file browser 
nautilus. Kemampuan file browser Nautilus mem-burning iso karena ada pada Ubuntu sudah terinstall paket  
nautilus-cd-burner.

Berikut langkah-langkah :

1. Siapkan file iso image yang akan diburning;

2. Klik kanan pada iso image tersebut dan pilih menu Write To Disc…;

3. Dijendela berikutnya, anda bisa:

• Memilih pembakar yang akan digunakan, CD/DVD writer;

• Memilih opsi Write Speed yang akan digunakan.

gambar 162: proses burning selesai

gambar 163: membakar melalui nautilus

gambar 164: setup disk



4. Pada jendela complete akan ditanyakan apakah akan membuat copy-an yang lain  "Make Another 
Copy" atau menutup jendela "Close".

➔ Glabels Labelling CD
Untuk membuat cd/dvd label anda dapat menggunakan aplikasi glabels. Alternatif lain software labelling cd 
pada  Ubuntu  anda  dapat  menggunakan  DiscWrapper yang  dapat  di  download  di 
ftp://repo.ugm.ac.id/ekstra/software/linux/other/discwrapper_1.1.3-0_i386.deb

Instalasi

1. Buka  aplikasi  Synaptic  Package  Manager  dengan  meng-klik  menu  System –> 
Administrations –>  Synaptic Package Manager, dalam daftar paket klik kanan pada paket 
glabels dan pilih Mark For Installation dan klik tombol Apply;

2. Atau melalui terminal, dengan mengetikkan perintah berikut :sudo apt-get install glabels

3. Jalankan aplikasi  Glabels dengan meng-klik menu  Applications  → Office  → glabels Label 
Designer;

gambar 165: selesai membakar

gambar 166: opsi membakar ulang



4. Perhatikan pemilihan template, sesuaikan dengan merk/ukuran label yang anda miliki;

5. Pada  Kotak  dialog  printing,  pilih  tab  label untuk  pengaturan  opsi  pencetakan  yang  akan 
dilakukan;

gambar 167: menu glabels

gambar 168: memilih ukuran dan jenis kertas

gambar 169: opsi printing label



Aplikasi Games di Ubuntu

Aplikasi Games
Tidak usah takut anda tidak akan bisa bermain game jika menggunakan ubuntu karena berbagai macam 
game sudah terdapat  di  repositori  ubuntu.  Untuk melakukan instalasi  dapat  dilakukan melalui  repositori  
online atau menggunakan DVD repositori

➔ Game Umum
Instalasi Games di Ubuntu bisa menggunakan aplikasi Add/Remove selain menggunakan Synaptic Package 
Manager yang bisa anda temukan di Application  → Add/Remove kemudian klik pada category Games.

Pada aplikasi ini terdapat berbagai kategori, untuk game terdapat pada kategori game dan education. Pada 
kategori game terdapat berbagai macam genre game, seperti 2D, 3D, fps (first person shooter), RPG (Role 
Playing Game), emulator, dan simulator. Beberapa contoh game yang terdapat di repositori ubuntu adalah 
Alien  Arena,  Billiard  GL,  Torcs,  dan  Flight  Gear.  Untuk  emulator  tersedia  antara  lain  emulator  Sony 
Playstation, NintendoDS, SNES, dan VisualBoyAdvance.

Alien  arena  adalah  game ber-genre  FPS (First  Person  Shooter)  dan  dapat  dimainkan  secara  jaringan 
(multiplayer). 

Game ini dapat berjalan di multi platform (Linux, Windows, dan MacOS). Informasi lengkap tentang alien 
arena terdapat di http://icculus.org/alienarena/rpa/

gambar 170: install paket game

gambar 171: game alien arena



TORCS (The Open Racing Car Simulator) adalah game simulasi balapan 3D yang juga dapat berjalan di 
multi platform. Informasi lengkap tentang TORCS terdapat di http://torcs.sourceforge.net

➔ Game Edukasi
Pada kategori education berisi permainan edukasi untuk anak-anak. Permainan edukasi terdapat permainan 
sebagai media pembelajaran yang cocok untuk TK, SD, dan SMP. Beberapa game yang terdapat di kategori 
ini adalah gcompris, celestia, Kalzium.

Permainan edukasi gcompris cocok untuk anak pada usia balita dan SD. Pada gcompris terdapat berbagai 
macam permainan  untuk  pembelajaran  seperti  berhitung,  pengenalan komputer,  dan ilmu pengetahuan 
alam. Permainan ini juga sudah dilengkapi dengan panduan berbahasa Indonesia baik teks maupun suara.  
Informasi lengkap tentang gcompris terdapat di http://gcompris.net.

gambar 172: game torcs

gambar 173: game gcompris



Aplikasi Internet

Internet Messaging

➔ Pidgin Internet Messaging
Pidgin merupakan aplikasi instant messaging yang dapat digunakan untuk berkomunikasi yang mendukung 
beberapa protokol messanging di internet, seperti AIM, Bonjour,Gadu-Gadu, Google Talk, GroupWise, ICQ, 
IRC,  MSN,  MySpaceIM,  QQ,  SILC,  SIMPLE,  Sametime,  XMPP,  Yahoo,  dan  Zephyr.  Alasan  utama 
mengganti gaim dengan pidgin pada Ubuntu Feisty karena fitur dan tampilan yang dimiliki jauh lebih baik.  
Fitur yang digunakan adalah mengirim dan menerima file menggunakan protokol Yahoo!,  fitur ini  sudah 
berjalan sangat baik pada Pidgin. Pidgin secara default digunakan pada versi Ubuntu setelah Feisty untuk 
menggantikan GAIM.

➔ Menggunakan Pidgin
Berikut cara penggunaannya :

1. Buka aplikasi Pidgin melalui Menu  → Application  → Internet  → Pidgin Internet Messenger.

2. Setelah aplikasi  pidgin terbuka maka anda akan diminta untuk memasukan user  account  terlebih 
dahulu di aplikasi pidgin ini.

3. Untuk membuat account maka klik tombol  Add, apabila anda akan menggunakan pidgin ini untuk 
chatting di yahoo maka ganti protokolnya dengan mengganti di bagian protocol dengan yahoo

gambar 174: jendela awal pidgin



4. Kemudian  apabila  anda akan  menggunakan  avatar di  pidgin  maka tinggal  mengisi  check  box  di 
bagian  Use this buddy icon for this account : kemudian klik tombol dibawahnya untuk memilih 
gambar yang akan anda gunakan sebagai avatar, kosongkan saja pada bagian Password dan Local 
alias, kemudian terakhir klik Save untuk menyimpan konfigurasi yang baru kita buat.

5. Untuk login maka anda akan dimintai untuk memasukan kata sandi anda (password), dan apabila 
anda ingin agar tidak ditanyai password setiap kali anda login maka isi check box Save password, 
kemudian tekan OK untuk melanjutkan ke proses login.

gambar 175: add account baru

gambar 176: menggunakan avatar lalu save



6. Setelah anda login maka anda akan masuk pidgin dan pidgin siap digunakan, berikut tampilan buddy 
list dari pidgin

➔ Mengganti smiley standar pidgin
1. Download  paket  smiley  di  sini  http://repo.ugm.ac.id/ekstra/.ugos_tools/59794-Original.tar.gz  dan 

tempatkan di home folder.

2. Pada menu bar Pidgin klik menu Tools  → Preferences, kemudian pada kotak Preferences pilih tab 
Smiley Themes dan tekan tombol  Add,  kemudian masukkan paket  smiley pdigin yang sudah di 
download tadi dan tekan Open.

gambar 177: memasukkan password

gambar 178: daftar teman



3. Kemudian untuk menggantinya cukup pilih emoticon yang baru kita install tadi dan tekan Close.

4. Untuk melihat perubahannya silahkan lakukan uji coba, silahkan buka emoticonnya

Catatan

File  emoticon  standar  yahoo  dapat  anda  download  disini 
http://repo.ugm.ac.id/ekstra/software/linux/messenger/Pidgin/Smiley/59794-Original.tar.gz

➔ Menambahkan daftar contact atau buddy list
1. Menambahkan buddy list atau daftar contact (yahoo messenger) dapat anda lakukan melalui menu 

Buddies  → Add Buddy, pada bagian Screen name isikan dengan account yahoo id orang yang akan 
anda add, dan pada bagian alias dapat anda isi dengan nama orang tersebut atau lainnya.

gambar 179: menu preferences

gambar 180: menambahkan smiley baru

gambar 181: smiley yang sudah diganti



➔ Mengirimkan file
1. Dengan menggunakan pidgin anda dapat saling bertukar file dengan teman-teman anda seperti anda 

menggunakanya di yahoo messenger, caranya pada menubar pilih teman yang akan anda kirimi file, 
kemudian klik Conversation  → Send file, kemudian buka file yang akan anda kirimkan  klik → Open , 
kemudian tunggu sebentar sementara file di transfer.

➔ Membuat conference
1. Untuk  membuat  conference  caranya  yaitu  klik  kanan  id  yang  akan  anda  ajak  dalam konferensi 

kemudian pilih menu Initiate Conference, maka setelah itu anda akan masuk di jendela conference.

gambar 182: menu add buddygambar 183: jendela menambahkan teman

gambar 184: menu file transfer

gambar 185: proses transfer dengan pidgin



➔ Mengganti status pidgin
1. Untuk mengganti status klik kanan icon pidgin di sistem tray desktop anda kemudian Change Status,  

pilih status anda dengan memilih salah satu status yang telah tersedia

1. Apabila anda menginginkan untuk mengganti message status anda dengan status sesuai keinginan 
anda, pada pilihan status tadi pilih menu Change Status  → Saved

2. Pada bagian Title isi dengan judul status yang anda inginkan, pada bagian status pilih salah satu 
status  kemudian  pada  bagian  Message  isikan  dengan  message  status  anda,  kemudian  untuk 
menggunakanya tekan tombol Save & Use.

gambar 186: menu initiate 
conference

gambar 187: jendela conference

gambar 188: mengganti status pidgin



3. Setelah mengganti message status anda tadi maka status anda akan menjadi seperti gambar berikut :

Firefox Web Browser
Pada Ubuntu  desktop,  dibagian kiri  atas  desktop klik  menu  Applications  → Internet  → Firefox  Web 
Browser Menggunakan Firefox relatif sama dengan browser lain dalam beberapa hal. Berikut aktifitas yang 
umumnya sering dilakukan oleh pengguna. Menjelajah web

gambar 189: jendela mengganti status

gambar 190: contoh status yang 
telah diganti



1. Jalankan browser Firefox, bisa melalui shortcut di dekstop atau menu aplikasi.

2. Tempatkan kursor pada Location Bar.

3. Ketikkan alamat web yang diinginkan, misal http://ugos.ugm.ac.id

➔ Tabbed Browsing
Pada saat menjelajah web kita biasanya membuka banyak jendela,  kegiatan ini  membuat repot apalagi 
ruang pada taskbar menjadi sempit untuk aplikasi lain yang ingin dijalankan. Tabbed Browsing adalah fitur  
pada Firefox yang mengakomodasi kebutuhan ini yaitu dengan menyediakan tab-tab berisi sub jendela yang 
bisa berisi web berbeda dan semuanya masuk dalam satu jendela utama. Menjelajah web kini menjadi lebih 
efisien, untuk berpindah web kita tinggal berpindah tab saja.

1. Pilih menu File  → New Tab atau shortcut dengan kombinasi tombol Ctrl+T;

2. Tab baru akan terbuka, silahkan isi dengan alamat web yang ingin Anda kunjungi;

3. Untuk berpindah web, klik tab yang diinginkan atau membuka lagi tab baru;

4. Gunakan shortcut kombinasi  Ctrl+PageUp untuk kembali ke tab sebelumnya dan  Ctrl+PageDown 
untuk menuju ke tab berikutnya.

➔ Melakukan Bookmarking
1. Kunjungi web favorit Anda.

2. Lakukan  bookmarking  dengan  cara  memilih  menu  Bookmarks  → Bookmark  This  Page,  atau 
dengan menekan kombinasi tombol Ctrl+D.

3. Pilih kategori yang Anda inginkan dan klik tombol Add.

4. Web Anda akan masuk ke daftar di menu Bookmarks sesuai kategori.

gambar 191: menu firefox

gambar 192: contoh tab browser

gambar 193: menu bookmark

http://ugos.ugm.ac.id/


➔ Pencarian di Web

1. Tempatkan kursor pada Search Bar atau menggunakan tombol kombinasi Ctrl-K;

2. Ketikkan  kata  atau  frase  yang  ingin  Anda  cari  di  web,  sesuaikan  dengan  mesin  pencari  yang 
diinginkan: Google, Yahoo, atau yang lainnya dan tekan Enter.

3. Segera hasil pencarian Anda akan ditampilkan di tab yang terbuka.

➔ Menyimpan

Menyimpan Halaman

1. Kunjungi situs atau halaman web yang Anda inginkan baik langsung atau melalui pencarian;

2. Untuk menyimpannya ke dalam penyimpan lokal pilih menu File  → Save Page As atau dengan 
shortcut tombol kombinasi Ctrl+S;

3. Muncul  dialog menanyakan nama dan tempat Anda akan menyimpan halaman tersebut,  isi 
sesuai  dengan  keinginan  atau  langsung  klik  tombol  Save  saja  untuk  menggunakan  nama 
berkasnya.

Menyimpan Gambar

1. Kunjungi situs favorit, galeri gambar atau cari di http://images.google.com

gambar 195: search bar disebelah kanan navigation bar

gambar 194: jendela bookmark

gambar 196: menu save page



2. Pilih gambar yang ingin Anda simpan;

3. Arahkan kursor mouse di atas gambar dan klik kanan;

4. Muncul menu dan pilih Save Image As… dan pilih lokasi penyimpanan yang diinginkan.

➔ Menghapus History, Cache, Cookies dan Lain-lain
Semua  browser  menyimpan  alamat  yang  pernah  dikunjungi  pada  history,  halaman  web  pada  cache, 
informasi  lain  pada  cookies,  form,  download  manager,  dan  lain-lain.  Untuk  menghapusnya,  Anda  bisa 
memilih Tools  Clear Private Data→ . Atau dengan menggunakan tombol Ctrl+Shift+Delete

➔ Plugin Firefox

Ad Block Plus

Adblock Plus adalah extension addon untuk mem-block iklan yang tampil pada halaman web. Addon 
ini berguna ketika membuka halaman web berita seperti detik.com atau kompas.com.

1. Buka aplikasi Synaptic Package Manager dengan meng-klik menu System  → Administrations 
 → Synaptic Package Manager;

2. Search dengan keyword "adblock-plus";

3. Klik kanan pada paket adblock-plus dan pilih Mark For Installation dan klik tombol Apply;

4. Atau melalui terminal, dengan mengetikkan perintah berikut : 

$ sudo apt-get install adblock-plus
5. Jalankan Firefox Web Browser, maka akan ada notifikasi dari adblock-plus addon.

Anda dapat menambahkan extension dari Firefox dengan meng-klik menu Tools  → Add-ons  → Get 
Add-ons  → Browse All Add-ons. ( Cara ini juga berguna untuk instalasi automatic updates Firefox.) 

gambar 197: menghapus private  
data

gambar 198: plugin adblock sudah diinstall



gambar 199: menu addon

gambar 200: jendela get add-on



Printing, Faxing, dan Scanning

Printing
Pada  umumnya  banyak  printer  sudah  secara  automatis  terdeteksi  secara  baik  drivernya  oleh  Ubuntu. 
Aplikasi  printer  configuration digunakan  untuk  menambahkan  printer,  atau  merubah  settingan  printer 
tersebut.  Anda juga bisa menggunakan aplikasi  ini  untuk me-share printer  dengan komputer  lain dalam 
sebuah jaringan, me-disable printer, atau me-restartnya.

➔ Printer Lokal
Yang dimaksud lokal printer adalah printer yang terkoneksi secara langsung ke dalam komputer. Untuk me-
setup lokal printer baru :

Colokkan kabel usb printer ke dalam komputer dan tekan tombol ON. Kebanyakan printer akan terdeteksi 
dan terkonfigurasi  secara automatis.  Ketika terdeteksi,  sebuah icon printer akan tampil  di  tray area dan 
beberapa detik kemudian, anda akan mendapatkan sebuah popup jendela bertuliskan "Printer is ready for  
printing".

Jika printer tidak terdeteksi, maka ikuti langkah berikut untuk instalasinya :

1. Ketahui nama model printer anda.

2. Pastikan printer dalam kondisi hidup atau ON.

3. Masuk ke menu System  → Administration  → Printing.

4. Sekarang pilih New Printer.

gambar 201: notifikasi pada system tray

gambar 202: menu printer



5. Printer akan terdeteksi secara automatis. Cukup mudah, hanya dengan klik Forward dan klik Apply.

6. Pada akhirnya, anda hanya menekan Enter didalam "deskription and location" untuk printer anda.

Jika driver printer tidak terdeteksi  automatis,  anda dapat memilih port  dan driver  printer secara manual. 
Beberapa printer membutuhkan setup. 

Search di database di website LinuxPrinting.org atau cek di halaman printer Ubuntu Wiki untuk kemungkinan 
informasi printer anda.

➔ Printer Jaringan
Anda dapat juga mengkonfigurasi sistem Ubuntu untuk mengirimkan job print kedalam remote printer server.  
Remote printer  merupakan host  dimana dalam sebuah jaringan.  Untuk mengkonfigurasi  sebuah remote 
printer, berikut langkah-langkahnya :

1. Ketahui nama model printer anda.

2. Pastikan printer dalam kondisi hidup atau ON.

3. Masuk ke menu System  → Administration  → Printing.

4. Sekarang pilih New Printer.

5. Jika printer anda terkoneksi kedalam mesin windows didalam jaringan anda, pilih Windows Printer via  
SAMBA. Kemudian pilih protokol yang akan digunakan.

6. Kemudian klik Browse, cari nama printer yang disharing pada jaringan

gambar 203: jendela printer configuration

gambar 204: printer via samba



7. Isikan detail dari "network printer" dan klik Forward.

8. Pilih model printer dan klik Apply. Apabila sharing printer Windows/Samba, anda harus menggunakan 
driver yang disediakan oleh system Linux

9. Untuk setting printer dengan model sharing ipp, klik Server  → Settings. bagian Show Pub

10. Selanjutnya beri tanda centang pada bagian Show Shared printer by other system

11. Terakhir, anda dapat menekan Enter didalam "description and location" untuk printer anda.

 

Jika anda tidak mengetahui protokol atau detail dari printer jaringan anda, anda harus konsultasi dengan 
administrator jaringan anda. 

➔ Testing Printer
Test dilakukan di lokal maupun didalam remote printer bekerja secara baik :

1. Pilih menu System  → Administration  → Printing.

gambar 205: daftar printer  
yang terdeteksi

gambar 206: menu 
setting server

gambar 207: centang show printer



2. Pilih nama printer dari daftar. Kemudian klik kanan  → Properties

3. Didalam jendela properties, klik "Print Test Page". Maka halaman test print akan di cetak.

Faxing
efax-gtk merupakan aplikasi yang digunakan untuk mengirim dan menerima fax menggunakan fax modem. 
Dapat juga digunakan sebagai "virtual printer" unutk mengirimkan fax dari pengolah kata dan program yang 
serupa, user yang diinginkan dapat secara automatis menerima fax via e-mail, dan dapat secara automatis 
mencetak fax yang diterima.

Anda dapat meng-instal paket efax-gtk dari repository "Universe" (baca Menambah   dan Menghapus Aplikasi   
pada http://ugos.ugm.ac.id/wiki/panduan:ubuntu_8.04_hardy_heron:menambah_dan_menghapus_aplikasi)

Untuk menjalankan efax-gtk, klik pada menu Applications  → Office  → Efax-gtk.

 efax-gtk membutuhkan dukungan dari fax modem yang terinstall secara baik. 

• Tampilan desktop efax-gtk

 

gambar 208: menu properties printer
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• Daftar fax yang sudah terkirim

 

• Jendela setting device fax dan daftar fax yang diterima

Untuk informasi lebih lanjut, silahkan kunjungi beberapa alamat situs dibawah ini :

• Ubuntu Community support pages - https://help.ubuntu.com/community/DialupAndFax

• Efax-gtk website - http://efax-gtk.sourceforge.net/

gambar  diambil  dari  Softpedia  -  http://linux.softpedia.com/progScreenshots/Efax-gtk-  Screenshot-  

gambar 210: jendela efax-gtk

gambar 211: sent item
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Scanning
Banyak scanner yang secara automatis didukung oleh Ubuntu, dan dengan sangat mudah ter-instal dan di  
operasikan.  Panduan ini  digunakan untuk  bagaimana menggunakan scanner  anda dan bagaimana jika 
Ubuntu tidak dapat mengenali driver scanner anda.

➔ Apakah scanner anda dapat digunakan di Ubuntu?
Ada tiga cara untuk mengetahui apakah scanner anda bisa bekerja pada Ubuntu :

1. Cukup mudah colokkan Universal Serial Bus (USB) scanner anda ke komputer, jika terdeteksi secara 
baik maka scanner dapat langsung digunakan.

2. Cek  pada  site  https://wiki.ubuntu.com/HardwareSupportComponentsScanners untuk  mengetahui 
driver scanner yang sudah didukung baik oleh Ubuntu.

3. Daftar project scanner yang didukung oleh  SANE (Scanner Access Now Easy) - http://www.sane-
project.org/sane-backends.html project  mendukung banyak  driver  terbaru  software  scanning  pada 
Ubuntu.

➔ Menggunakan scanner
Untuk me-scan dokumen, anda tinggal mengikuti beberapa langkah berikut :

1. Tempatkan dokumen yang akan di scan didalam scanner.

2. Jalankan XSane Image Scanner dengan men-klik menu Applications  Graphics  XSane Image→ →  
Scanner. 

3. Alternatif, tekan scan button pada scanner juga bisa.

➔ Instalasi Manual Scanner
Ada beberapa scanner yang sedikit  mempunyai driver yang komplet dari  project SANE. Terkadang bisa 
digunakan, tapi tidak semua fitur dapat bekerja secara sempurna.

• Pastikan  Universe  repository  sudah  dimasukkan  dalam  daftar  source.lst  (baca  Menambah  dan 
Menghapus  Aplikasi  - 
http://ugos.ugm.ac.id/wiki/panduan:ubuntu_8.04_hardy_heron:menambah_dan_menghapus_aplikasi).

• Jika menggunakan modus grafik search paket libsane-extras pada Synaptic Package Manager atau 
melalui modus teks dengan mengetikkan perintah :

$ sudo apt-get install libsane-extras
• Edit pada file /etc/sane.d/dll.conf dan hilangkan komen (hapus tanda #) pada driver yang sesuai dengan 

scanner anda.

$ sudo gedit etc/sane.d/dll.conf

gambar 213: deteksi scanner
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• Jalankan sane dan lakukan scanning dokumen.

 

Because of the way Ubuntu's hotplugging stuff works, you may need to plug in the scanner after the 
computer has booted. If you're having problems seeing the scanner, you might want to try this.

➔ XSane Image Scanner
Anda  dapat  menggunakan  XSane  untuk  mengontrol  scanner  dan  mengambil  gambar  dari  itu.  Dengan 
XSane, anda dapat dengan mudah mem-photocopy dokumen dan menyimpannya, fax atau e-mail gambar 
scan anda. Hasil scan dapat di scan sebagai multi-page dokumen, didalam halaman, satu halaman file. 

• Jalankan aplikasinya dengan klik menu Applications  → Graphics  → XSane Image Scanner.

XSane juga bisa digunakan menggunakan aplikasi pengolah grafik The Gimp; klik menu File  → Acquire → 
XSane untuk men-scan secara langsung untuk mendapatkan gambar. 

Network Settings

Konfigurasi Setting Network (mode grafis)
Agar dapat terkoneksi dengan jaringan yang ada, baik melalui kabel, wireless ataupun modem setting dapat 
diatur  dengan  melakukan  klik  kanan  pada  icon  Network  Connection  pada  panel  kemudian  pilih  Edit 
Connection
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Maka setelah itu akan muncul tampilan seperti  berikut Tekan tombol Unlock agar anda dapat mengedit 
konfigurasi network

➔ Konfigurasi Network Statis
Untuk mengkonfigurasi koneksi menggunakan kabel pada bagian Wired pilih Auto eth0 kemudian klik menu 
Edit dan kemudian akan muncul tampilan berikut

Selanjutnya pilih pada tab  IPv4 Settings,  pada bagian  Method pilih  Manual dan pada bagian ip isikan 
nomer  ip  yang akan  kita  masukan,  misalkan  192.168.1.2  dengan netmask 255.255.255.0  dan  gateway 
192.168.1.254, kemudian pada bagian DNS Server isikan DNS server dengan DNS server di tempat anda, 
hasil akhir dari settingan network kira-kira akan seperti berikut 
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gambar 217: setting profile eth0



➔ Konfigurasi Network DHCP
Untuk konfigurasi  network otomatis via DHCP, diasumsikan disini kita akan membuat profile baru untuk 
koneksi  dengan  ip  automatic  (dhcp),  langkahnya  adalah  sebagai  berikut,  masih  di  jendela  Network 
Connections klik Add dan setelah itu akan muncul jendela editing, pada Connection Name isikan dengan 
profile koneksi anda sesuai dengan keinginan anda, disini akan diberi nama dengan dhcp

kemudian  pilih  pada  tab  IPv4  Setings dan  pada  bagian  Method pilih  Automatic  (DHCP) 
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Konfigurasi Network (Modus Teks)

➔ Mengenali ifconfig
Untuk  melakukan  konfigurasi  jaringan,  di  Sistem Operasi  Linux,  menggunakan  perintah  dasar  ifconfig 
ifconfig ini memiliki opsi dasar 

$ ifconfig <nama_device> <alamat_ip> 
contoh: 

$ ifconfig eth0 192.168.0.1 
Jika  didalam  komputer  terdapat  dua  LAN card  atau  lebih,  dapat  dilihat  dahulu  daftar  LAN card  yang 
terdeteksi dengan perintah ifconfig tanpa opsi 

contoh: 

$ ifconfig 
eth0      Link encap:Ethernet  HWaddr 00:02:44:3B:49:91 
          inet addr:10.13.177.11  Bcast:10.13.255.255  Mask:255.255.0.0 
          inet6 addr: fe80::202:44ff:fe3b:4991/64 Scope:Link 
          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1 
          RX packets:3383763 errors:330 dropped:817 overruns:330 frame:0 
          TX packets:457390 errors:0 dropped:0 overruns:1 carrier:0 
          collisions:0 txqueuelen:1000 
          RX bytes:2682586516 (2.4 GiB)  TX bytes:36126278 (34.4 MiB) 
          Interrupt:5 Base address:0x2000 
lo        Link encap:Local Loopback 
          inet addr:127.0.0.1  Mask:255.0.0.0 
          inet6 addr: ::1/128 Scope:Host 
          UP LOOPBACK RUNNING  MTU:16436  Metric:1 
          RX packets:8 errors:0 dropped:0 overruns:0 frame:0 
          TX packets:8 errors:0 dropped:0 overruns:0 carrier:0 
          collisions:0 txqueuelen:0 
          RX bytes:776 (776.0 b)  TX bytes:776 (776.0 b) 
untuk melihat daftar jaringan yang lebih lengkap, atau melihat apa saja yang tersedia, perintah  ifconfig 
ditambah opsi -a yang berarti all contoh hasil: 

$ ifconfig -a
eth0      Link encap:Ethernet  HWaddr 00:02:44:3B:49:91 
          inet addr:10.13.177.11  Bcast:10.13.255.255  Mask:255.255.0.0 
          inet6 addr: fe80::202:44ff:fe3b:4991/64 Scope:Link 
          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1 
          RX packets:3383763 errors:330 dropped:817 overruns:330 frame:0 
          TX packets:457390 errors:0 dropped:0 overruns:1 carrier:0 
          collisions:0 txqueuelen:1000 
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          RX bytes:2682586516 (2.4 GiB)  TX bytes:36126278 (34.4 MiB) 
          Interrupt:5 Base address:0x2000 
eth1      Link encap:Ethernet  HWaddr 00:e2:c4:fB:d1:91 
          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1 
          RX packets:0 errors:0 dropped:0 overruns:0 frame:0 
          TX packets:0 errors:0 dropped:0 overruns:1 carrier:0 
          collisions:0 txqueuelen:1000 
          RX bytes:0 TX bytes:0 
          Interrupt:5 Base address:0x2000 
lo        Link encap:Local Loopback 
          inet addr:127.0.0.1  Mask:255.0.0.0 
          inet6 addr: ::1/128 Scope:Host 
          UP LOOPBACK RUNNING  MTU:16436  Metric:1 
          RX packets:8 errors:0 dropped:0 overruns:0 frame:0 
          TX packets:8 errors:0 dropped:0 overruns:0 carrier:0 
          collisions:0 txqueuelen:0 
          RX bytes:776 (776.0 b)  TX bytes:776 (776.0 b) 

➔ Memberikan Alamat IP
untuk memberikan ip pada lancard yang kedua tinggal berikan ip yang sesuai dan tuliskan ke device yang 
bersangkutan, contoh: 

$ ifconfig eth1 192.168.10.1 
pada jaringan dengan aturan-aturan khusus, seperti pada subnet, opsi ifconfig menjadi seperti berikut 

$ ifconfig <nama_device> <alamat_ip> netmask <susunan_netmask> 
Pada umumnya, konfigurasi alamat ip cukup seperti diatas, untuk tingkatan konfigurasi yang lebih pakar, 
dapat dibaca pada panduan ifconfig dengan perintah 

$ man ifconfig 

Seluruh file konfigurasi pada ifconfig tersimpan pada /etc/network/interfaces

➔ Memberikan Alamat Gateway
Perintah  route  ini  secara  dasar  digunakan untuk  mengisikan gateway pada sistem,  tapi  secara umum, 
perintah route ini  dapat melalukan fungsi routing, atau memberikan arahan pada jaringan dan/atau sub-
jaringan yang ada. Komputer yang diterapkan aturan route ini, maka komputer tersebut sudah dapat disebut 
sebagai router Untuk mengisikan gateway (default gateway) digunakan perintah route add default gateway 
<alamat_ip> contoh: 

$ route add default gateway 192.168.0.254 
untuk melihat hasil route dapat dilihat dengan perintah 

$ route -n 
contoh: 

$ route -n 
Kernel IP routing table 
Destination     Gateway         Genmask         Flags Metric Ref    Use Iface 
169.254.0.0     0.0.0.0         255.255.0.0     U     1000   0        0 eth0 
10.13.0.0       0.0.0.0         255.255.0.0     U     0      0        0 eth0 
0.0.0.0         10.13.1.254     0.0.0.0         UG    0      0        0 eth0 
Untuk menghapus gateway, digunakan perintah 

$ route del default gateway <alamat_ip> 
contoh: 

$ route del default gateway 192.168.0.254 
Untuk berperan sebagai router, menggunakan opsi sebagai berikut 

$ route add -net <alamat_jaringan> netmask <susunan_netmask> gateway <alamat_gateway> 
dev <nama_eth> 
Keterangan;



• alamat_jaringan: berupa alamat jaringan yang akan dirutekan oleh router, format alamat jaringan ini 
berkaitan erat dengan netmask-nya

• susunan_netmask: berupa susunan netmask untuk menunjukkan bagian mana yang alamat jaringan 
dan alamat host 

• alamat_gateway: merupakan gateway dari alamat jaringan yang ingin dihubungkan, umumnya berisi 
alamat ip yang berada satu kelompok dengan alamat jaringan router

• nama_eth: eth yang mana yang digunakan untuk terhubung dengan gateway di jaringan tersebut. 

contoh: 

$ route add -net 192.168.30.0 netmask 255.255.255.0 gateway 192.168.10.1 dev eth1 
Jika dilihat table route-nya maka akan menghasilkan table berikut 

$ route -n 
Kernel IP routing table 
Destination     Gateway         Genmask         Flags Metric Ref    Use Iface 
192.168.30.0    192.168.10.1    255.255.255.0   U     1000   0        0 eth1 
169.254.0.0     0.0.0.0         255.255.0.0     U     1000   0        0 eth0 
10.13.0.0       0.0.0.0         255.255.0.0     U     0      0        0 eth0 
0.0.0.0         10.13.1.254     0.0.0.0         UG    0      0        0 eth0 

➔ Memberikan Nameserver
Di berkas /etc/resolv.conf tersimpan alamat DNS server yang bertugas meresolve (menerjemahkan) alamat 
yang  berbasis  nama,  ke  alamat  ip.  Jadi  misalkan  kita  mengetikkan  ugm.ac.id  maka  sistem  akan 
mengirimkan nama ugm.ac.id ini ke DNS server yang tercatat di berkas ini, dan mengembalikan kepada 
sistem  alamat  ip-nya.  Untuk  memberikan  alamat  DNS  server  cukup  mudah..  cukup  buka  berkas 
/etc/resolv.conf dengan editor favorit anda;

$ sudo vim /etc/resolv.conf
kemudian tambahkan baris 

nameserver <alamat_dns_server> 
contoh:

nameserver 172.16.30 
simpan berkas tersebut, dan proses pengenalan DNS server ke sistem telah selesai.

 

Semua perintah diatas perlu dijalankan dengan akses root,karena perintah-perintah diatas berpotensial 
mengacaukan jaringan sistem anda, pastikan hanya pemegang akses root yang bisa melakukan perintah 
diatas. 

Wireless
Wireless yang dibahas dalam tulisan ini adalah langkah-langkah mengkoneksikan Ubuntu intrpid ibex anda 
yang terinstall di notebook atau netbook, dengan asumsi hardware sudah dikenali dengan baik.

➔ Pengaturan Wireless

Mode Grafis

Koneksi cepat

Mengatur koneksi wireless dapat dilakukan dengan mudah di ubuntu intrepid ibex, dengan cara 
meng-klik pada icon Network Notification Area pada panel atas bagian kanan, sebagai berikut:



 

• Jika pengaturan wireless anda tanpa Wireless Policy (WEP/WPA/PSK) anda dapat langsung 
terkoneksi dengan jaringan wireless yang anda pilih.

Mengatur setingan Profile untuk pengaturan wireless

Pengaturan profile ini akan meudahkan kita apabila kita memiliki beberpa jenis koneksi wireless 
dengan  masing-masing  setingan  yang  berbeda.  misalkan  kita  biasa  menggunakan  layanan 
wireless  di  kampus  A  dengan  wireless  policy  proteksi  WEP  dengan  memasukkan  user  dan 
password, kemudian ada lagi wireless di Unit Pelayanan umum dengan koneksi wireless tanpa 
proteksi (Open), ini lah gunanya penggunaan setting profile, kita dapat dengan cepat mengubah 
setingan wireless  sesuai  dengan konsisi  dan tempat  yang sudah kita  set  sebelumnya.  berikut 
langkah-langkah membuat setingan profile di wireless

1. Buka Jendela Network Configuration:

gambar 222: menu network config

Atau dengan cara lain yang lebih cepat, dengan klik kanan pada icon Network Notification Area 
dan pilih Edit Connection, berikutnya akan muncul jendela pengaturan network sebagai berikut:

gambar 221: daftar sinyal wireless



gambar 223: jendela konfigurasi wireless

2. Pilih pada tab wireless untuk memilih profile wireless yang ingin anda set, jika masih kosong 
silakan  buat  profile  baru  dengan  cara  mengklik  button  Add dan  akan  muncul  Editing 
Wireless connection sebagai berikut:

gambar 224: setting profile  
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Masukkan  nama  profile  yang  ingin  anda  pilih  pada  Field  Connection  Name,  untuk  otomatis 
terkoneksi silakan check pada checklist "Conncet automatically" dan apabila anda berkeinginan 
mengeset  sebagai  koneksi  default  untuk  mesin  anda,  silakan  check  pada  checklist  "System 
Setting". Pengaturan masing-masing profilenya dapat disesuaikan pada tab "Wireless", "wireless 
Security",  "IP4 Settings",  secara umum pengaturan pemberian IP pada wireless menggunakan 
DHCP server sehingga pengaturan pada tab "IP4 Setting" biasa diset pada pilihan DHCP.

3. Pengaturan dengan menggunakan sistem profile ini  akan menghemat waktu anda untuk 
mengeset setingan wireless, anda cukup memilih jenis profile yang ingin anda gunakan dari  
Icon "Network Notification" dan pilih nama profile anda.

Mode Teks

Mode ini masih belum bisa ditinggalkan oleh pengguna, karena penggunaan mode ini dirasa lebih 
cepat. berikut langkah langkah yang dilakukan:

1. Buka terminal Menu » Application » Accessoris » Terminal

2. Aktifkan button wireless pada notebook anda terlebih dahulu.

3. Mengecek konfigurasi network:



$ sudo ifconfig
4. akan  muncul  pesan  konfigurasi  network  adapter  anda,  terbaca  sebagai  wlan0,  hasil 

pengenalan network ini bervariasi untuk masing-masing merek.

    wlan0 Link encap:Ethernet  HWaddr 00:16:cf:33:56:78
          inet addr:192.168.1.54  Bcast:192.168.1.255  Mask:255.255.255.0
          inet6 addr: fe80::216:cfff:fe33:5678/64 Scope:Link
          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1
          RX packets:6424 errors:0 dropped:0 overruns:0 frame:0
          TX packets:1938 errors:0 dropped:0 overruns:0 carrier:0
          collisions:0 txqueuelen:1000
          RX bytes:928329 (928.3 KB)  TX bytes:906691 (906.6 KB)
          Interrupt:18 Memory:d0100000-d0102000 

5. mengaktifkan wireless (wlan0)

$ sudo ifconfig wlan0 up
6. Jika sudah wireless sudah aktif berikutnya dilakukan scanning untuk mendeteksi layanan 

wireless

$ sudo iwlist wlan0 scan
7. Hasil pencarian

wlan0     Scan completed :
Cell 01 - Address: 00:18:F8:B6:C5:7F
          ESSID:"pptik-01"
          Protocol:IEEE 802.11g
          Mode:Managed
          Frequency:2.437 GHz (Channel 6)
          Quality:81/100  Signal level:-44 dBm  Noise level:-96 dBm
          Encryption key:off
          Bit Rates:1 Mb/s; 2 Mb/s; 5.5 Mb/s; 6 Mb/s; 9 Mb/s
          11 Mb/s; 12 Mb/s; 18 Mb/s; 24 Mb/s; 36 Mb/s
          48 Mb/s; 54 Mb/s
          Extra:bcn_int=100
          Extra:atim=0 

8. Berikutnya mengkoneksikan dengan wireless dengan ESSID "pptik-01" 

$ sudo iwconfig wlan0 essid "pptik-01"
9. Mendapatkan IP untuk dari DHCP server wireless $ sudo dhclient wlan0

10. Mendapatkan IP address:

Internet Systems Consortium DHCP Client V3.1.1
Copyright 2004-2008 Internet Systems Consortium.
All rights reserved.
For info, please visit http://www.isc.org/sw/dhcp/

Listening on LPF/wlan0/00:16:cf:33:56:78
Sending on   LPF/wlan0/00:16:cf:33:56:78
Sending on   Socket/fallback
DHCPDISCOVER on wlan0 to 255.255.255.255 port 67 interval 5
DHCPOFFER of 192.168.1.54 from 192.168.1.1
DHCPREQUEST of 192.168.1.54 on wlan0 to 255.255.255.255 port 67
DHCPACK of 192.168.1.54 from 192.168.1.1
bound to 192.168.1.54 -- renewal in 284 seconds.

banyak jalan menuju Mekah, begitu juga dengan file server atau populer kita sebut sebagai sharing 
file antar PC. Pada Ubuntu anda dapat menggunakan Samba, NFS, atau menggunakan aplikasi 
Giver (khusus Intrepid Ibex)

Samba
Sebelum dapat membuat sharing dengan samba, user harus memiliki akses menulis konfigurasi sharing di 
folder  /var/lib/samba/usershares.  Agar  user  memiliki  akses  menulis  (Write) di  konfigurasi  samba, 
tambahkan group user menjadi group sambashare

Untuk mengakses folder sharing samba baik pada ubuntu Hardy/Intrepid, default menggunakan user dan 



password, anda juga dapat memberikan akses share tanpa username dan password dengan mengaktifkan 
opsi Guest Access.

➔ Langkah-langkah untuk memulai sharing file samba Modus Grafis;
1. Klik kanan pada salah satu folder yang ingin akan anda sharing, pilih menu Sharing Options

2. Pada jendela Sharing Option, beri tanda cek di share Share this Folder

3. Apabila PC anda belum terinstall samba, system akan otomatis meminta konfirmasi instalasi melalui 
repository terdekat

4. Verifikasi untuk merestart session pc anda, agar samba dapat berjalan
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5. Pada jendela Sharing options, juga terdapat opsi Guest Access, dengan opsi ini semua orang dapat 
melihat isi folder sharing

6. Setelah  instalasi  service  sharing,  selanjutnya  anda  harus  memberikan  user  hak  akses  menulis 
konfigurasi  kedalam folder  /var/lib/samba/usershares.  Apabila belum memiliki  hak akses jendela 
sharing akan memunculkan pesan seperti dibawah

7. Buka  Menu  System  Administration   Users  and  Group→ → ,  kemudian  klik  unlock  keys dan 
masukkan password untuk dapat mengubah properti user 

8. Klik manage group, kemudian pada list pilih group sambausers (baris paling bawah)
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9. Selanjutnya klik ganda pada group sambausers, dan masukkan user pada group samba user dengan 
memberikan tanda cek

10. Logout  kemudian  login  kembali  untuk  menerapkan  perubahan.  Cek  kembali  dengan  melakukan 
sharing folder seperti pada langkah 1 diatas.

➔ Langkah-langkah sharing samba modus teks;
1. Install samba server

$ sudo apt-get install samba
2. berikan password samba

$ sudo smbpasswd -a USERNAME
3. Edit file smb.conf

$ sudo gedit /etc/samba/smb.conf
4. kemudian tambahkan baris berikut di bagian paling bawah file smb.conf;

[test]
path = /home/USERNAME/test
available = yes
valid users = USERNAME
read only = no
browsable = yes
public = yes
writable = yes

5. Restart Samba

$ sudo /etc/init.d/samba restart
6. Jalankan perintah testparm untuk melihat hasilnya

$ testparm

➔ Menggunakan System-Config-Samba
Anda juga dapat menggunakan utility system-config-samba untuk melakukan konfigurasi samba, termasuk 
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menambahkan dan menggubah password user samba.

Install system-config-samba menggunakan synaptic atau dengan perintah; 

sudo apt-get install system-config-samba
Jalankan system-config-samba pada menu System  Administrations  samba→ →

Utility ini membutuhkan akses sudo, masukkan password anda, apabila diminta. Berikut tampilan system-
samba-config

Untuk mengubah password user atau menambahkan user samba, pilih menu Preferences  Samba users→ .

➔ Melihat hasil Sharing Samba
Untuk mengecek hasil sharing pada Ubuntu, buka nautilus anda. Pada side panel sebelah kiri[F9], klik icon 
network

Atau anda dapat mengklik icon  di kiri atas pada nautilus, pada location ketikkan smb:// untuk melihat 
seluruh sharing pada local network.

Untuk melihat sharing melalui modus teks, ketikkan perintah smbtree, seperti contoh dibawah; 

$ smbtree
WORKGROUP
 \\UGOS-UBUNTU     ugos-ubuntu server (Samba, Ubuntu)
 \\UGOS-UBUNTU\soft            
 \\UGOS-UBUNTU\Print_to_PDF    Print to a PDF File
 \\UGOS-UBUNTU\LaserJet-manda LaserJet-manda
 \\UGOS-UBUNTU\LaserJet-1022a LaserJet-1022a
 \\UGOS-UBUNTU\LaserJet-1022-new LaserJet-1022-new
 \\UGOS-UBUNTU\LaserJet-1022-1 LaserJet-1022-1
 \\UGOS-UBUNTU\PDF             PDF
 \\UGOS-UBUNTU\Color-LaserJet-4700 Color-LaserJet-4700
 \\UGOS-UBUNTU\printer         hp-1020
 \\UGOS-UBUNTU\print$          Printer Drivers
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 \\UGOS-UBUNTU\foto            
 \\UGOS-UBUNTU\ugos            
 \\UGOS-UBUNTU\IPC$            IPC Service (ugos-ubuntu server (Samba, Ubuntu))
 \\PRASTOWO-LAPTOP prastowo-laptop server (Samba, Ubuntu)
cli_start_connection: failed to connect to PRASTOWO-LAPTOP<20> (0.0.0.0). Error 
NT_STATUS_BAD_NETWORK_NAME
 \\PPTIK           pptik server (Samba, Ubuntu)
 \\PPTIK\BJC-1000SP      BJC-1000SP
 \\PPTIK\LaserJet_6L     laser-jet-tempat-bu-muhar
 \\PPTIK\PDF             PDF
 \\PPTIK\IPC$            IPC Service (pptik server (Samba, Ubuntu))
 \\PPTIK\print$          Printer Drivers
 \\NUNUG-DESKTOP   nunug-desktop server (Samba, Ubuntu)
 \\NUNUG-DESKTOP\mp3_pv          
 \\NUNUG-DESKTOP\printer         hp-1020
 \\NUNUG-DESKTOP\IPC$            IPC Service (nunug-desktop server (Samba, Ubuntu))
 \\NUNUG-DESKTOP\print$          Printer Drivers
 \\MANDA-DESKTOP   manda-desktop server (Samba, Ubuntu)
 \\MANDA-DESKTOP\printer         hp-1020
 \\MANDA-DESKTOP\LaserJet-1022   LaserJet-1022-new
 \\MANDA-DESKTOP\IPC$            IPC Service (manda-desktop server (Samba, Ubuntu))
 \\MANDA-DESKTOP\manda           
 \\MANDA-DESKTOP\print$          Printer Drivers
 \\LEPPINYAAFIA    leppinyaAfia server (Samba, Ubuntu)
...

Network File System (NFS)
Selain menggunakan samba, anda juga dapat membuat file server dengan NFS. Konsep yang ditawarkan 
nfs adalah kita dapat membuat sebuah file server dan mengatur hak akses baca-tulis berdasarkan ip/user 
dan user quota.

NFS dikembangkan dengan tujuan suatu komputer dapat me-mount direktori atau partisi pada komputer lain 
seolah-olah direktori atau partisi tersebut terletak pada hard disk lokal.  Dengan kata lain NFS bertujuan 
untuk sharing file-file antar komputer. 

Dari  segi  keamanan,  NFS  juga  memungkinkan  orang  untuk  melakukan  modifikasi  pada  direktori  atau 
harddisk yang di-mount seperti  menghapus file, membaca dokumen pribadi yang terdapat pada direktori 
atau harddisk yang di-mount, dan sebagainya, namun hal ini dapat dicegah jika kita mengkonfigurasi NFS 
secara benar. 

NFS juga dibuat untuk berjalan pada lingkungan Unix. Dengan kata lain apaun jenis sistem operasi anda 
asalkan memenuhi standar POSIX, maka anda dapat berbagi pakai file dengan denggunakan NFS. Sistem 
operasi  tersebut  diantaranya  Linux,  Berkeley  Software  Distribution  Family  (BSD,  FreeBSD,  NetBSD, 
OpenBSD), Unix Family(Tru64 Unix, HP- UX, AIX, IRIX) dan Sun Family(Solaris,SunOS). 

Terdapat beberapa teknologi bagi pakai file selain NFS, sebut saja Samba yang dibuat untuk lingkungan 
Windows, Andrew File System yang dikembangkan oleh IBM dengan lisensi open source, dan Coda File  
System yang dikembangkan oleh kalangan Universitas. 

➔ Setting Server NFS

Instalasi NFS Server

Untuk membuat sebuah server NFS, sebelumnya harus menginstal terlebih dahulu paket nfs server 
dengan  nama  paket  nfs-kernel-server.  Cara  installasinya  dapat  menggunakan  synaptic  melalui 
System  Administration  Synaptic Package Manager → → . Perhatikan gambar dibawah; 



Paket yang akan kita install adalah nfs-common dan nfs-kernel-server. Paket nfs-common berfungsi 
sebagai client  yang akan me-mount filesystem yang ada di  network,  sedangkan paket nfs-kernel-
server berperan sebagai server yang menyediakan servis untuk melayani mounting directori di bagian 
server.

Untuk instalasi menggunakan terminal, jalankan perintah;

$sudo apt-get install nfs-common nfs-kernel-server

Konfigurasi NFS server

Setelah proses instalasi, selanjutnya anda harus mengkonfigurasi file /etc/exports. Syntax umum yang 
dapat anda gunakan adalah;

direktori workstation1(opsi1) workstation2(opsi2) 
1. Direktori : nama direktori yang akan di-share. Aturannya disini, jika anda melakukan sharing 

suatu direktori induk, maka semua direktori di bawahnya juga akan ikut ter-share. 

2. workstation1 dan workstation2 :nama klien yang diperbolehkan mengakses direktori tersebut 
diatas. Nama disini dapat berupa nama domain atau alamat IP dari workstation tersebut. 

3. opsi1 dan opsi2: pilihan disini menentukkan hak akses dari workstation terhadap direktori yang 
di-share. Beberapa pilihan yang bisa digunakan diantaranya : 

• ro:read-only. Sehingga klien hanya punya hak baca saja. Ini merupakan pilihan default. 

• rw : klien memiliki hak baca dan tulis terhadap direktori yang di-share. 

• no_root_squash: root  pada komputer  klien akan memiliki  hak yang sama dengan root 
pada server NFS. 

• no_subtree_check: biasanya NFS memiliki mekanisme pengecekan apakah file yang akan 
diminta  klien  termasuk  bagian  yang  di-share.  Dengan  adanya  opsi  ini  maka  akan 
mempercepat proses transfer, karena pengecekan akan ditiadakan. 

• sync: untuk  sinkronisasi  antara  perubahan  yang  dilakukan  oleh  klien  dengan  direktori 
sebenarnya di server. 

Contoh Langkah-langkah konfigurasi NFS server;

1. Buka file /etc/exports dengan perintah sudo gedit /etc/exports

2. Tambahkan baris seperti  contoh dibawah, sesuaikan dengan network anda dan folder yang 
ingin di sharing

/home/data-share 192.168.1.1(rw)  192.168.1.2(ro) 
/usr/local         *(rw) 
/media/data   (ro,sync)

3. Restart service nfs server dengan perintah sudo /etc/init.d/nfs-server restart

➔ Mengakses sharing NFS dari Client
Setting client pada NFS cukup sederhana. Kita menggunakan perintah mount yang lazim digunakan untuk  
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mounting filesystem. Contohnya sebagai berikut : 

$sudo mount -t nfs 192.168.1.1:/media/data-share /media/data-share-klien
Sebelum kita me mount direktori nfs, kita buat terlebih dahulu direktori yang akan kita gunakan untuk me-
mount, sebagai contoh diatas kita buat nama folder /media/data-share-klien. 

Semua  data  yang  ada  di  direktori  /media/data-share  di  server  akan  otomatis  berada  di  di  direktori  
/media/data-share-klien

Untuk unmounting maka cukup kita ketikkan perintah berikut : 

$sudo umount /media/data-share-klien 
Berikut langkah-langkah mounting otomatis sharing nfs pada saat booting

1. Edit file /etc/fstab sudo gedit /etc/fstab

2. tambahkan opsi mount pada baris paling bawah, seperti contoh dibawah (sesuaikan no ip dan folder 
yang disharing) 

192.168.1.1:/media/data-share /media/data-share-klien nfs rw,users,noauto 0 0 
3. Restart PC anda

Sebelumnya juga perlu diketahui apakah folder yang di share tersebut dapat ditulisi atau hanya dapat dibaca 
saja. Jika hanya dapat dibaca saja maka ganti  rw menjadi  ro. Dengan cara tersebut maka jika kita ingin 
melihat folder tersebut tinggal meng-klik saja pada file browser.

Berbagi file dengan Giver
Melalui protokol khusus giver, anda dapat membroadcast folder sharing yang diinginkan keseluruh pc dalam 
satu lokal network. Untuk melihat/mengambil file yang disharing dari sisi client juga harus menggunakan 
aplikasi giver.

Sayangnya paket Giver hanya tersedia di Ubuntu Intrepid Ibex. Singkat kata, Sharing file menggunakan 
Giver hanya dapat dilakukan antara pc dengan system operasi Ubuntu Intrepid Ibex.

Install Giver dengan synaptic, atau menggunakan perintah; 

$ sudo apt-get install giver

Aplikasi yang sudah terinstall ada di menu Applications  → Internet  → Giver
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Administrasi Desktop
Agar system dapat berjalan lebih optimal, semakin sedikit service yang berjalan semakin banyak kita dapat  
menghemat resource komputer  yang digunakan. Kita perlu melakukan pengaturan service dan session. 
Anda juga perlu mengetahui service apa saja yang berjalan pada system. Pengaturan dapat kita lakukan 
baik menggunakan modus grafis ataupun command line.

Pengaturan Service dan Session (Modus Grafis)

➔ Service
Untuk  menyesuaikan  service-service  apa  saja  yang  kita  butuhkan  dan  menghilangkan  yang  tidak  kita 
butuhkan, caranya yaitu : 

1. Buka aplikasi Services Manager dengan meng-klik menu System  → Administration  → Services.

 

2. Tekan  tombol  Unlock lalu  masukkan  password,  untuk  mematikan/menghidupkan  service  yang 
diinginkan.

 

3. Beberapa service yang dapat anda matikan antara lain;

• anacron;

• atd;

• bluetooth;
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• alsa-utils

• brltty 

• cups (apabila tidak menggunakan printer).

Sayangnya tidak semua service yang ada tampil pada jendela pengaturan grafis. Anda dapat melakukan 
pengaturan yang lebih advance melalui modus teks.

➔ Session
Apabila service dijalankan oleh system maka Session adalah service yang dijalankan oleh user dan masing-
masing user bisa mengatur sessionnya sendiri.  Dengan kata lain session adalah start-up program yang 
berjalan pada saat user login. Untuk mengatur session langkah-langkahnya sebagai berikut :

1. Buka aplikasi Session Manager dengan meng-klik menu System  → Preferences  → Sessions.

2. Anda dapat mematikan session yang tidak diperlukan. Hal ini akan sangat berguna untuk menghemat 
resource pada komputer anda.

3. Beberapa proses yang dapat dimatikan antara lain;

• Bluetooth

• Check New Hardware

• Evolution alarm

• Tracker

• Tracker Applet

• Update Notifier

• Visual Assistance

• GNOME Keyring Daemon Wrapper
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• GNOME Login Sound

• GNOME Settings Daemon

• GNOME Settings Daemon Helper

• Remote Desktop

• Power Manager

4. Apabila anda akan menambahkan aplikasi lain yang akan anda jalankan tiap anda login ke desktop 
maka klik tombol Add maka akan muncul kotak dialog seperti gambar dibawah :

5. Pada baris Command, masukkan nama aplikasi  yang ingin dijalankan secara otomatis pada saat 
anda login.

Pengaturan Service (Modus Teks)
Default Ubuntu ketika awal booting menjalankan Runlevel 2 (init 2)

➔ Melihat Service yang Berjalan
Untuk melihat daftar service yang berjalan pada runlevel 2 pada Ubuntu, ketikkan perintah;
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$ ls /etc/rc2.d
Contoh hasil yang muncul;

$ ls /etc/rc2.d/
README        S10powernowd.early           S12dbus          S20apport        S20nfs-
kernel-server  S20samba    S25bluetooth   S89atd           S99laptop-mode
S01policykit  S10sysklogd                  S17portmap       S20cupsys        S20nvidia-
kernel      S20winbind  S25pulseaudio  S89cron          S99rc.local
S05vbesave    S10xserver-xorg-input-wacom  S18avahi-daemon  S20hotkey-setup 
S20powernowd          S24dhcdbd   S30gdm         S98usplash       S99rmnologin
S10acpid      S11klogd                     S20apmd          S20nfs-common    S20rsync 
S24hal      S89anacron     S99acpi-support  S99stop-readahead

➔ Mematikan/Menghidupkan Service
Dari daftar service yang telah dilihat, anda dapat menentukan service yang dapat dimatikan. Acuhkan saja  
angka-angka pada nama service tersebut. Misalnya S16ssh, artinya service ssh.

Sebagai contoh Untuk mematikan service ssh, dapat menggunakan perintah;

$ sudo update-rc.d -f ssh remove
Anda juga dapat mematikan service-service yang tidak diperlukan, seperti service  avahi-daemon dan nfs-
common. Contoh perintahnya;

$ sudo update-rc.d -f avahi-daemon remove
$ sudo update-rc.d -f nfs-common remove
Untuk menghidupkan kembali service yang telah dimatikan, perintahnya;

$ sudo update-rc.d -n samba defaults

Perintah diatas artinya menghidupkan service samba

Optimasi menggunakan Ubuntu Tweak
Ubuntu Tweak adalah aplikasi grafis untuk optimasi dan pengaturan desktop Gnome Ubuntu. Ubuntu Tweak 
sangat berguna bagi orang awam yang ingin mengutak-atik desktop tanpa harus menyentuh terminal/modus 
teks. 

Download ubuntu-weak dari situsnya di  http://ubuntu-tweak.com/downloads, ukuran paket-nya cukup kecil 
cuma sekitar 900KB.

Install Ubuntu Tweak dengan mengklik ganda paket installer yang telah anda download, jangan lupa untuk 
menekan tombol unlock untuk mendapat akses install, seperti gambar dibawah

Setelah instalasi selesai, menu ubuntu Tweak dapat anda lihat pada menu Application  System Tools → → 
Ubuntu Tweak
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Pada layar welcome Ubuntu Tweak menunjukkan fungsi-fungsi yang dapat digunakan, seperti kustomisasi 
desktop, pengaturan service dan session, serta mengubah informasi PC. Silahkan berekspriment dengan 
Ubuntu Tweak ketika melakukan optimasi desktop anda

Pada contoh dibawah, penulis menggunakan ubuntu Tweak untuk optimasi session. Pilih menu Startup → 
Session Control  Autostart→ . Dibagian itu kita dapat mengurangi/menambah aplikasi yang jalan ketika 
pertama kali login
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Administrasi User (Modus Grafik)
Linux merupakan salah satu sistem operasi yang mendukung multi user dan untuk melakukan administrasi 
user buka menu System  Administrasion  Users and Groups→ →  maka akan muncul menu Administrasi 
user seperti gambar berikut.

➔ Menambahkan User

Tekan tombol  Unlock kemudian masukkan password usernya. Untuk menambahkan user baru di sistem 
gunakan tombol Add User maka setelah itu anda akan menemukan tampilan berikut

Keterangan;
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1. Username : pada bagian username isikan dengan login name

2. Real Name : isikan dengan nama asli dari pengguna (optional)

3. Profile : isikan dengan profile user tersebut nantinya akan sebagai  Administrator, atau user biasa 
(Desktop User) 

4. Pada  bagian  Contact  Inormation kita  dapat  mngabaikanya  dan  pada  bagian  Password isikan 
dengan password user.

➔ Manage Groups
Untuk manage group klik tombol Manage Groups maka akan muncul tampilan seperti berikut;

Untuk menambahkan group klik Add Group, untuk mengubah group pilih groupnya dan klik Properties dan 
pilih Delete, untuk menghapus group.

Administrasi User (Modus Teks)

➔ Menambahkan User
Buka aplikasi konsole terminal dengan klik Menu –> Accesories –> Terminal dan lakukan-langkah berikut : 

$ sudo adduser test 
maka akan tertampil sebagai berikut : 

[sudo] password for test:
Adding user `test' ...
Adding new group `test' (1004) ...
Adding new user `test' (1003) with group `test' ...
Creating home directory `/home/test' ...
Copying files from `/etc/skel' ...
Enter new UNIX password: 
Retype new UNIX password: 
passwd: password updated successfully
Changing the user information for test
Enter the new value, or press ENTER for the default
        Full Name []: user-test
        Room Number []: 
        Work Phone []: 
        Home Phone []: 
        Other []: 
Is the information correct? [y/N] y
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➔ Menghapus User
$ sudo deluser test 

➔ Menambahkan Group
$ sudo adduser --group [--gid ID] administrator 
Untuk file konfigurasi group berada pada /etc/group.

➔ Menghapus Group
$ sudo deluser --group administrator 

➔ Memasukkan User Kedalam Group
$ sudo usermod -G administrator test 

GDM (Gnome Display Manager)
GDM (Gnome Display  Manager),  Digunakan  untuk  mengatur  tampilan  pada layar  login  Ubuntu.  Untuk 
melakukan pengaturan GDM anda memerlukan akses sudo atau root. Pengaturan GDM dengan meng-klik  
Menu  System  Administration  Login Window→ → → .

➔ Mengubah Tampilan GDM
Langkah-langkahnya sebagai berikut :

5. Download  paket  gdm Theme UGOS  di  http://repo.ugm.ac.id/ekstra/.ugos_tools/oxygdm.tar.gz dan 
tempatkan kedalam lokal folder home.

6. Pada menu Login Preferences Pilih tab Local.

7. Klik button Add kemudian pilih paket theme oxygdm.tar.gz didalam home foler, kemudian klik tombol 
Install. 
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➔ Auto Login
Secara default Ubuntu tidak mengaktifkan opsi Auto Login, namun untuk memudahkan pengguna terkadang 
opsi ini kita perlukan. Langkah-langkahnya :

1. Pada jendela Login Window Preferences, pilih tab Security.

2. Aktifkan opsi  dengan meng-klik  tanda checkboard pada  Enable Automatic Login kemudian pilih 
nama user yang akan kita izinkan untuk otomatis login ke sistem.

Customisasi Desktop
Customisasi desktop pada Ubuntu disesuaikan dengan desktop yang dirancang team UGOS agar terlihat 
nyaman  dan  mudah  digunakan  oleh  pengguna.  Beberapa  perubahan  yang  akan  terjadi  pada  shortcut 
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desktop, panel, theme icon, dan GTK theme. Berikut langkah-langkah customisasinya :

➔ Edit Panel
1. Hapus beberapa shortcut panel seperti  Menu Bar,  Firefox,  Evolution,  Help, dan Quit dari panel atas 

(klik kanan  remove from panel→ ).

2. Hapus panel bar bagian bawah (klik kanan  delete this panel→ ).

3. Tarik (drag) panel dari atas ke bawah.

4. Tambahkan Main Menu, Show Desktop, Firefox, Pidgin, Window List (klik kanan pada panel  add→  
to panel).
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5. Untuk mengatur posisi,  klik kanan pada shortcut panel dan pilih  Move,  geser posisi shortcut agar 
sesuai. 

6. Lock Panel ( klik kanan shortcut pada panel  lock panel→ ).

Mengganti Menu Panel

Langkah-langkahnya : 

1. Download icon panel-nya di http://repo.ugm.ac.id/ekstra/.ugos_tools/start.png.

2. Copykan icon panel kedalam directory "/usr/share/pixmaps/" melalui konsole dengan perintah 
berikut  :  
 $ sudo cp start.png /user/share/pixmaps/ 

3. Buka aplikasi Configuration Editor dengan menekan Alt+F2 ketikkan gconf-editor. 

4. Pada configuration editor buka subtree "/apps/nautilus/panel/objects/object_2" (tanpa tanda 
petik)  setelah itu isikan pada "custom_icon"  dengan string "/usr/share/pixmaps/start.png" 
dan beri tanda centang pada "use_custom_icon". Seperti gambar dibawah ini :
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Untuk object_X pada registry disesuaikan dengan kondisi komputer masing-masing.

Mengganti Background Panel

1. Download  paket  panel  di  http://repo.ugm.ac.id/ekstra/.ugos_tools/panel-silver.png dan 
tempatkan di dalam home folder.

2. Pindah paket panel-silver.png melalui konsole dengan mengetikkan perintah berikut : 

$ sudo mv panel-silver.png /usr/share/pixmaps/
3. Buka  aplikasi  Configuration  Editor  dan  buka  subtree 

"/apps/panel/toplevels/top_panel_screen0/background/"  isikan  sesuai  dengan  keterangan 
dibawah ini

• image isi dengan string /usr/share/pixmaps/panel-silver.png

• type isi dengan string image

Me-Lock Panel

Agar  panel  tidak  bisa  diubah-ubah,  maka  lakukan  lock  panel  dengan  cara  :

1. Buka configuration editor seperti langkah diatas.

2. Kemudian pada configuration editor buka subtree  “/apps/panel/global/” (tanpa tanda petik)  
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3. Beri tanda centang pada string “locked_down”, seperti gambar dibawah ini :

4. Maka ketika klik kanan pada panel tidak akan muncul menu  add panel maupun  edit panel, 
hasilnya seperti di bawah ini :

➔ Icon Theme
Agar tampilan icon pada desktop terlihat lebih nyaman dilihat, 

1. Download  icon  theme  dari  UGOS di  download  di  http://repo.ugm.ac.id/ekstra/.ugos_tools/Human-
Blue-icon.tar.gz dan tempatkan kedalam folder home.

2. Buka menu Appearance dengan meng-klik Menu  → Preferences  → Appearance.

3. Klik button Install, kemudian add paket Human-Blue-icon.tar.gz, kemudian klik Apply New Theme 
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pada kotak dialog yang muncul.

➔ GTK Theme
GTK theme merupakan theme untuk merubahan tampilan border window. Langkah-langkah merubahnya 
sebagai berikut :

1. Download  paket  GTK  theme  UGOS  dapat  di  download  di 
http://repo.ugm.ac.id/ekstra/.ugos_tools/NotXP.tar.gz dan tempatkan didalam folder home. 

2. Buka menu Appearance dengan meng-klik Menu  → Preferences  → Appearance.

3. Pada menu Appearance klik button Install, kemudian add paket NotXP.tar.gz, selanjutnya klik Apply 
New Theme pada kotak dialog yang muncul.

➔ Control Theme
1. Untuk merubah control theme klik Menu  Preferences  Appearance→ → .

2. Klik button Customize, kemudian pada tab Control pilih theme ClearlooksClassic.
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➔ Mengganti Wallpaper
1. Download wallpaper Ugos di sini  http://repo.ugm.ac.id/ekstra/.ugos_tools/warty-final-ubuntu.png dan 

tempatkan kedalam folder home.

2. Klik kanan pada desktop, pilih opsi "Change Desktop Background", seperti tertampil berikut.

3. Pada dialog Appearance Preferences, klik tombol Add dan tambahkan paket wallpaper yang sudah 
didownload ke dalam folder home tadi.
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➔ Shortcut Desktop
Untuk  membuat  shortcut  desktop  seperti  My  Computer,  My  Documents,  serta  Recycle  Bin,  langkah-
langkahnya sebagai berikut :

1. Buka aplikasi configuration editor dengan menekan Alt+F2 ketikkan “gconf-editor”, seperti cara yang 
telah diterangkan sebelumnya

2. Pada configuration editor buka subtree “/apps/nautilus/desktop” (tanpa tanda petik) dan beri tanda 
centang pada registry berikut : 

• computer_icon_visible; 

• home_icon_visible; 

• trash_icon_visible.

3. Selanjutnya edit key berikut dengan men-double klik nama registry-nya :

• computer_icon_name isi dengan My Computer dengan type string;

• home_icon_name isi dengan My Documents dengan type string;

• trash_icon_name isi dengan Recycle Bin dengan type string.
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Menambah Shortcut Aplikasi di Desktop

Tambahkan shortcut desktop aplikasi dengan cara sebagai berikut :

1. Klik menu Applications, pilih aplikasi berdasarkan kategori, semisal menambahkan shortcut ke 
desktop Firefox berada pada kategori Internet, selanjutnya klik kanan dan Add this launcer to 
desktop seperti pada gambar dibawah ini.

2. Tambahkan shortcut desktop untuk aplikasi di bawah ini :

• OpenOffice.org Writer,

• OpenOffice.org Calc,

• Audacious,

• Pidgin Internet Messenger,

• Firefox Web Browser,

• Mplayer Movie Player.

3. Kemudian ganti nama masing-masing aplikasi menjadi :
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• OpenOffice.org Word,

• OpenOffice.org Excel,

• Audacious Mp3 player,

• Firefox Web Browser,

• Pidgin Yahoo Messenger,

• Mplayer Movie Player.

➔ Finishing
Hasil akhir desktop setelah di kustomisasi :

Desktop Effect Compiz, dan Sound

➔ Desktop Effect
Desktop  effect  yang  disediakan  secara  default  oleh  ubuntu  dapat  secara  langsung dijalankan,  asalkan 
requirement  hardwarenya  memenuhi  persyaratan  minimal,  untuk  dapat  menjalankan  desktop  effect  ini,  
disarankan menggunakan RAM minimal 1GB dan VGA yang mendukung pula. Pembahasan desktop effect 
akan dibagi menjadi dua pokok bahasan, yang pertama desktop effect defaul dari proses fresh install ubuntu 
intrepid  ibex  dan  pokok  bahasan  yang  kedua  adalah  dengan  penambahan  aplikasi  tambahan  agar 
menambah effect yang diperoleh.

Settingan default saat pertama kali fresh install

Mengaktifkan Desktop effect

• Buka pada jendela Appereance Preference:

  System >> Preferences >> Appearance 
Dapat dilihat pada gambar berikut ini
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• Berikutnya muncul jendela Preference Appearance, berikutnya pilih pada tab Visual Effect.

Aktifkan pilihan untuk masing-masing tingkatan effect, yang pertama adalah None (Tanpa Effect),  
Normal (Penggunaan Desktop Effect sederhana), Extra(Penggunaan effect yang lebih). 

Efect Normal

Mengaktifkan pilihan Normal pada pengaturan desktop effect akan memberikan anda pengaturan 
effect yang sedang atau sederhana, dapat diaplikasika untuk penggunaan harian, untuk mencoba 
melihat  aksi  effect  nya  adalah  dengan  melihat  perpindahan  antar  window,  shortcut  yang 
digunakan: 

[ Alt ] + [ Tab ]
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Akan terlihat perpindahan antar jendela yang kita buka, misalkan kita buka file manager, mozilla 
firefox dll, berikut tampilan perpindahan tab nya

 

Effect Extra

Effect  extra ini  membutuhkan penggunaanresource yang lebih,  maka dari  itu disarankan untuk 
tidak mengaktifkan pada mode ini pada saat bekerja, kecuali  jika anda memiliki resource yang 
besar. Mengaktifkan pada mode ini, kita akan disuguhi efek woobbly windows, jendela akan terlihat 
kenyal  apabila  digerakkan  menggunakan  mouse,  dapat  bergoyang  seakan  kenyal  seperti 
jelly,berikut tangkapan layar dari effect woobly pada mode pilihan extra effect.

Setingan dengan tambahan aplikasi pelengkap

Secara default, effect yang sudah dijelaskan diatas sudah bagus sebagai desktop effect yang layak 
untuk dipamerkan. Compiz sudah dibundel secara default pada ubuntu yang mampu menampilkan 
woobly effect dan transcluent.namun apabila anda memiliki resource lebih dan mempunyai keinginan 
untuk mendapatkan desktop effect  yang lebih wah dan bervariasi  lagi,  anda dapat menambahkan 
compiz fusion,  Compiz  fusion adalah proyek  software  dari  http://freedesktop.org yang merupakan 
merge antara compiz extra dan Beryl project, yang keduanya konsen menangani composit window 
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manager.

• Installasi aplikasi tambahan (CompizConfig-setting-manager)

System >> Administration >> Synaptic Package Manager
• Lakukan pencarian dengan kata kunci "compiz", lakukan checklist untuk paket  compizconfig-

setting-manager kemudian pilih apply untuk menerapkan installasi.

• Jalankan desktop effect seperti pada langkah pertama, baik dengan mode Normal atau extra, 
kemudian baru di setting untuk efek tambahan melalui compizconfig setting manager

System >> Preferences >> Compizconfig Setting Manager
Jendala pengaturan yang akan muncul seperti pada gambar dibawah ini:

Compiz Setting Manager dibagi menjadi beberapa kategori: 

• General :  Bagian ini  adalah setingan global untuk Compiz anda, berisi  tweaking tool  dari 
Compiz:

• Accessibility :  bagian ini  mengijinkan anda untuk menkonfigurasi  Viewing  ,  semua yang 
berkaitan dengan pengaturan view (Helper, Brightness & Saturation, Colour Filter, Enhanced 
Desktop Zoom, Show Mouse, Magnifier, Negative and Opacity):

gambar 276: jendela setting compiz manager

gambar 277: setting general

gambar 278: setting accessibility



• Desktop : Bagian ini untuk memulai pengaturan dektop, beberapa pilihan yang dapat kita pilih  
antara  lain  :Clone  Output  ,  Desktop  Cube,  Desktop  Plane,  Desktop  Wall,  Expo,  Fade to 
Desktop, Rotate Cube, Show Desktop, Viewport Switcher dan Widget Layer:

• Effects : Bagian ini untuk mengatur efek tambahan lebih menambah daya tarik desktop anda, 
beberapa efek yang dapat diaplikasikan disini antara lain: Consists of 3D Windows, Animation, 
Bicubic Fllter,  Blur Windows, Motion Blur, Cube Gear, Cube Atlantis, Cube Deformation & 
Reflection,  Fading  Windows,  Snow,  Log  In/LogOut,  Minimize  Effect  ,  Paint  Fire  On  the 
Screen , Reflection, Water Effect, Trailfocus, Windows Decoration and Wobbly Windows:

• Extra :  Bagian ini  merupakan pengaturan untuk efek ekstra seperti:Annotate,  Benchmark, 
Screenshot, Splash and Windows Preview:

• Image Loading : Bagian ini adalah untuk pengaturan image processing yang disupport pada 
saat compiz sedang di load:

gambar 279: setting desktop

gambar 280: settting effect

gambar 281: setting extras



• Utility :  Bagian ini  mengatur  primary plugins yang mengizinkan compiz untuk berinteraksi 
dengan komponen tambahan secara mudah dan efektif. pengaturan yang ada pada bagian ini 
antara lain Crash Handler, Cube Caps, Dbus, Error Notification, Glib, Inotify , Mouse Position 
Polling,  Regex  Matching,  Resize  Info,  Scale  Addon,  Scale  Window  title  filter,  Userspace 
Filesystem, Session Managment, Video Playback, Workaround:

• Windows Management : Bagian ini berisi plugin yang digunakan untuk pengaturan windows, 
terdapat beberapa efek yang diantaranya Application Switcher, Extra WM Action, Group Tab 
and Windows,  Maximumize,  Place Windows,  Put,  Resize Windows,  Ring Switcher,  Scale, 
Shelf, Shift Switcher, Snapping Windows, Windows Rules:

• Uncategorized :  Plugin  yang  belum  masuk  Kategori,  berisi  dua  pengaturan  yaitu  Move 
Windows dan Zoom Desktop:

 

gambar 282: setting image loading

gambar 283: setting utility

gambar 284: window management

gambar 285: setting uncategory



• Silakan  lakukan  pengaturan  sesuai  dengan  keinginan  efek  yang  di  perlukan,  terkadang 
mengenable  kan  efek  yang  satu  akan  mendisable  efek  yang  lain,  namun  dapat  dicoba 
beberapa  fitur  efek  yang  ditawarkan.  Kadang  jika  terlalu  banyak  menerapkan  efek  akan 
menimbulkan desktop no-respon/hank, untuk meresetnya gunakan

[Ctrl]+[Alt]+[Back-space]
Sebagai Gambaran beberapa efek yang bisa digunakan sebagai preview akan dibahas berikut ini. 

Efek-efek yang tersedia di compiz Fusion

berikut  ini  hasil  tangkapan layar  dari  beberapa desktop  effect  yang  diperoleh  dengan mengubah 
setting pada compizconfig-settng-manager.

3D Desktop

Salah satu fitur yang menarik dari Compiz Fusion adalah kemampuan 3d desktop Cube, Sphere, 
atau  silinder,  Plugin  ini  memberikan  hasil  3d  desktop  dengan  optimal  eye  candy,  diperlukan 
pengaktivan ketika semua hal yang berkaitan dengan plugin yaitu Rotate Cube, Cube deformasi  
dan Plugin, Cube Caps. Plugin ini  berguna pada saat pernggunaan beberapa workspace atau 
berpindah Multiple Desktop. Berikut tampilan desktop 3d hasil tangkapan layar:

 

gambar 286: efek 3d desktop 1

gambar 287: efek 3d desktop 2



Key Bindings / Shortcuts : CTRL + ALT + Mouse 1

Unfold

Bagian  ini  memberikan  tampilan  pergeseran  desktop  cube,  dengan  mengaktifkan  fitur  ini 
perpindahan antar Desktop akan semakin indah 

Key Bindings / Shortcuts : CTRL + ALT + Down Arrow Key

3D Windows

Plugin ini akan mengubah tampilan biasa ke tampilan 3d, dengan mengaktifkan Desktop Cube 
Plugin.

Animation

Plugin  ini  memebrikan  bermacam-macam  efek  yang  dapat  anda  aktifkan  untukmempercantik 
desktop anda, beberapa pilihan efek diantaranya efek untuk Minimizing/Maximizing/Opening dan 
Closing  Windows,  efek  ini  sangat  mudah  unuk  dikustomisasi,  dengan  banyak  sekali  pilihan 
konfigurasi, efek yang bisa digunakan antara lain: Airplane, Beam Up, Burn, Curved Fold, Domino, 
Dream, Explode, Fade, Fold,  Glide 1 and 2,  Horizontal  Fold,  Leaf Spread, Magiz Lamp, Razr, 
Sidekick, Skewer, Vaccum, Wave and Zoom, anda juga dapat mengatur pada pengaturan random 
untuk menerapkan semua efek yang tersedia. Berikut beberapa preview:

gambar 288: efek 3d desktop 3gambar 289: efek 3d desktop 4

gambar 290: efek animasi 1



dan masih banyak lagi Animation lain yang dapat dicoba.

Expo

Plugin  Expo  ini  banyak  dimanfaatkan  untuk  pengelolaan  dokumen  atau  window,  dengan 
mengaktifkan Expo ini, kita akan lebih mudah memilih workspace yang ingin kita kunjungi, 

Key Bindings / Shortcuts : SUPER [Windows Key] + E
Tampilan Expo :

gambar 291: efek animasi 2gambar 292: efek animasi 3

gambar 293: expo 1



Windows Switcher

Compiz  datang  dengan  3  window  switcher  yang  secara  default  indah  dan  menarik.  dengan 
switcher ini akan memudahkan kita untuk memilih wondow yang akan kita gunakan untuk bekerja, 
selain mempercepat pemilihan media kerja juag menawarkan keindahan, sudah tersedia beberapa 
pilihan switcher sebagai berikut:

Application  Switcher :  -  Application  Switcher  adalah  switcher  yang  paling  sederhana, 
perpindahan antar jendela dianimasikan dengan thumbnail dari window yang bersangkutan, jika 
anda suka perindahan yang sederhana, Application switcher ini yang cocok untuk anda:

Ring Switcher : - Ring Switcher adalah plugin lama yang dikembangkan di Beryl Barracks, bagian 
ini  akan  memberikan  efek  transisi  window  yang  mengagumkan  denga  efek  modern  yang 
ditampilkannya:

gambar 294: expo 2

gambar 295: window switcher biasa



Swift Switcher : - Efek transisi ini mengikuti perkembangan trend saat ini, perpindahan window 
similar dengan perpindahan album pada iTunes, berikut hasil tangkapan layarnya:

Key Bindings / Shortcuts : CTRL + SHIFT + S

gambar 296: ring switcher

gambar 297: swift swicther 1

gambar 298: swift switcher 2



Group Tab and Windows

Group  tab  and  Windows  memberikan  dukungan  untuk  penggunaan  single  window,  dengan 
mengelompokkan  beberapa  window  menjadi  satu  keatuanuntuk  memudahkan  meindahkan 
ketempat lain, misalkan ke workspace lain. 

Key Bindings / Shortcuts : Selection : ALT + S
Tabbing : ALT + T

Accesbilty Plugins

Plugin  ini  memudahkan user  untuk mengatur  tampilan sesuai  dengan keinginannya,  plugin  ini 
diantaranya:

1. Brightness and Saturation

2. Enhanced Zoom / Desktop Zoom

3. Colour Filter

4. Negative

5. Show Mouse..

Pain Fire & Annotate Plugin

Bagian Plugin ini mendukung untuk membuat tulisan di desktop anda dengan berbagai efek yang 
disediakan, diantaranya efek api, titik air dan Pen. berikut sebagian kecil hasil tangkapan layar dari  
efek ini:

gambar 299: efek api

➔ Sound

Pengaturan Sound Preferences

Ubuntu Intrepid Ibex sudah menggunakan pulse audio sebagai penggnti alsa sound driver mulai Rilis 
Hardy  Heron  (8.04)  dengan  penggunaan  Pulse  audio  ini,  kopatibilitas  terhadap  soundcard  lebih 
meningkat dibandingkan dengan versi terdahulunya. Pengaturan sound secara general diatur pada : 

System >> Preferences >> Sound
jendela inilah yang digunakan untuk pengaturan sound 



Pengaturan Device

Pada bagian ini pengaturan yang berkaitan dengan Konfigurasi hardwware:

• Sound Events,  pengaturan  sound ini  untuk  sound sound yang digunakan untuk  desktop 
sound, secara default pemilihan sound playback adalah Autodetect, namun bila dalam kasus 
tertentu mengalami maslah dapat disesuaikan sesuai kebutuhan.

• Music adn Movies :Bagian ini untuk pengaturan pengaturan device untuk Music dan video, 
secara default sound playnback nya adalah Autodetect

• Audio  Conferencing:  Bagian  in  pengaturan  untuk  penggunaan  device  untuk  komunikasi 
misalkan dengan tambahan microphone atau tambahan lain, untuk melakukan pengetesan 
devide dapat menggunakan button test.

• Default Mixer Tracks: Bagian untuk memilih mixer yang sesuai dengan jenis soundcard dan 
typenya.

Pengaturan Sound

Pada bagian tab ini  anda dapat membuat  pengaturan desktop anda sesuai  dengan keinginan 
anda,  anda dapat  mengubah themes spund anda,  mengubah masing-masing detil  dari  sound, 
misalkan sound pada saat Login, startup -sound , windows maximize, windows minimize dan lain 
sebagainya. untuk mengubah sound nya cukup dengan menklik pada label Default dan mengubah 
value nya menjadi custom, kemudian silakan pilih sound file yang ingin anda gunakan.

gambar 300: jendela sound preferences



Volume Control

Pengaturan volume secara cepat dengan mengatur dari panel kanan atas ubuntu anda, pada icon 
Volume master, untuk pengaturan yang lebih komplek dapat dengan doubla click pada icon tersebut 
dan akan muncul jendela volume manager sebagai berikut:

 

gambar 301: pengaturan sound alert

gambar 302: jendela volume control



Troubleshooting

Troubleshooting Umum

➔ Memeriksa Driver
1. Buka Terminal dengan meng-klik menu Applications  → Accessories  → Terminal.

2. Jalankan perintah ;

$ sudo lshw -V 
3. Apabila ada driver yang terdaftar, artinya device sudah aktif.

➔ Memeriksa Koneksi Wireless ke Router
1. Pada terminal ketik perintah;

$ iwconfig
2. Apabila ada tulisan ESSID="", selanjutnya lihat bagian configurasi WPA.

3. Apabila ESSID sudah muncul, namun belum terkoneksi, artinya ada masalah dengan ACPI. Coba 
boot kernel tapa dukungan acpi, dengan menambahkan baris pci=noacpi pada grub.

➔ Memeriksa IP
1. Pada terminal ketikkan perintah

$ ifconfig
2. Apabila sudah ada nomor IP, selanjut baca bagian cek DNS.

3. Apabila menggunakan dhcp, ketikkan perintah

$ sudo dhclient [interface]  Interface adalah nama interface network yang aktif 
(biasanya eth0).

➔ Memeriksa DNS
1. Pada terminal ketikkan perintah ;

$ ping [IP_DNS]
2. Apabila anda mendapat respon, artinya dns berjalan dengan baik.

3. Ketikkan perintah

$ cat /etc/resolv.conf
untuk  melihat  konfigurasi  DNS  yang  anda  gunakan.  Hubungi  administrator  jaringan  anda  untuk 
mengetahui alamat DNS yang digunakan pada jaringan anda.

Mengembalikan Grub yang Hilang
Terkadang  jika  instalasi  Ubuntu  tidak  beres,  atau  Windows  NT  bootloader  menimpa  MBR  dan  tidak 
mengenali instalasi linux, maka kita harus mengembalikan Grub bootloader agar dapat booting kedalam 
Linux. 

➔ Cara yang pertama
1. Pertama-tama kita harus mempersiapkan Ubuntu Live CD;

http://www.ugos.ugm.ac.id/wiki/panduan:ubuntu_8.04_hardy_heron:konfigurasi_dan_troubleshooting_bootloader


2. Kemudian ubah pada BIOS, boot CD pada urutan pertama (first boot option);

3. Setelah  masuk  Live  CD  Desktop  jalankan  terminal  dengan  meng-klik  menu  Applications → 
Accessories  → Terminal;

4. Cek partisi Linux kita dengan menggunakan perintah berikut :

$ sudo fdisk -lM
5. Setelah diketahui partisi Linuxnya kemudian lakukan mounting seperti berikut ini : (di misalkan partisi  

Linux adalah sda2)

  $ mount -t ext3 /dev/sda2 /mnt
  $ mount -t proc proc /mnt/proc
  $ mount -t sysfs sys /mnt/sys
  $ mount -o bind /dev /mnt/dev
  $ chroot /mnt  /bin/bash

6. sekarang kita akan mengembalikan GRUB ke MBR;

$ grub-install /dev/sda
7. sekarang kita akan mengembalikan kedalam partisi Linuxnya (misalkan:/dev/sda2);

$ grub-install /dev/sda2
8. Jika tidak ada pesan error maka setelah reboot sistem, bootloader akan kembali seperti semula.

➔ Cara yang kedua
1. Pertama-tama kita harus mempersiapkan Ubuntu Live CD;

2. Kemudian ubah pada BIOS, boot CD pada urutan pertama (first boot option);

3. Setelah  masuk  Live  CD  Desktop  jalankan  terminal  dengan  meng-klik  menu  Applications → 
Accessories  → Terminal;

4. Cek partisi Linux kita dengan menggunakan perintah berikut :

$ sudo fdisk -l
5. Masuk dalam grub;

$ sudo grub
6. Selanjutnya lakukan langkah berikut : 

grub> find /boot/grub/stage1

• misalkan  didapatkan  hasil  (hd0,3),  ini  adalah  informasi  yang  akan  kita  gunakan  untuk 
mensetup pada tahap selanjutnya.

7. Kemudian melakukan setup instalasi Grub :

grub> root (hd0,3)
grub> setup (hd0)

8. Jika proses installasi sudah selesai, keluar dari shell GRUB.

grub> quit

Konfigurasi Ulang Xserver yang crash
Permasalahan yang  sering  terjadi  biasanya  adalah  terjadi  perubahan  pada  resolusi  monitor  di  ubuntu.  
Sebenarnya permasalahan ini bisa diatasi dengan menjalankan perintah : 

$ sudo dpkg-reconfigure xserver-xorg
Namun untuk distro ubuntu diatas versi 7.10, perintah di atas tidak sepenuhnya menyelesaikan masalah, 
sehingga di perlukan edit manual file /etc/X11/xorg.conf. Untuk melakukan editing lakukan langkah berikut di 
terminal anda : 

$ sudo pico /etc/X11/xorg.conf



secara default isinya adalah sebagai berikut (xorg.conf ubuntu 8.10) : 

  # xorg.conf (X.Org X Window System server configuration file)
  #
  # This file was generated by dexconf, the Debian X Configuration tool, using
  # values from the debconf database.
  #
  # Edit this file with caution, and see the xorg.conf manual page.
  # (Type "man xorg.conf" at the shell prompt.)
  #
  # This file is automatically updated on xserver-xorg package upgrades *only*
  # if it has not been modified since the last upgrade of the xserver-xorg
  # package.
  #
  # Note that some configuration settings that could be done previously
  # in this file, now are automatically configured by the server and settings
  # here are ignored.
  #
  # If you have edited this file but would like it to be automatically updated
  # again, run the following command:
  #   sudo dpkg-reconfigure -phigh xserver-xorg

  Section "Device"
        Identifier      "Configured Video Device"
  EndSection

  Section "Monitor"
        Identifier      "Configured Monitor"
  EndSection

  Section "Screen"
        Identifier      "Default Screen"
        Monitor         "Configured Monitor"
        Device          "Configured Video Device"
  EndSection

Untuk  mengembalikan  resolusi  monitor  menjadi  1024×768,  setelah  sebelumnya  terjadi  perubahan  atau 
error, anda dapat edit file diatas menjadi seperti berikut ini :

Section "InputDevice"
 Identifier "Generic Keyboard"
 Driver "kbd"
 Option "XkbRules" "xorg"
 Option "XkbModel" "pc105"
 Option "XkbLayout" "us"
EndSection

Section "InputDevice"
 Identifier "Configured Mouse"
 Driver "mouse"
 Option "CorePointer"
EndSection

Section "Device"
 Identifier "Configured Video Device"
 Driver "vesa"
EndSection

Section "Monitor"
 Identifier "Configured Monitor"
 HorizSync 31.0 - 48.0
 VertRefresh 50.0 - 70.0
EndSection

Section "Screen"
 Identifier "Default Screen"
 Monitor "Configured Monitor"



 Device "Configured Video Device"
 DefaultDepth 24
 SubSection "Display"
 Viewport 0 0
 Depth 24
 Modes "1024x768" "800x600"
 EndSubSection
EndSection

Section "ServerLayout"
 Identifier "Default Layout"
 Screen "Default Screen"
EndSection

selanjutnya tinggal di simpan. Karena saya menggunakan text editor pico, sehingga untuk menyimpan cukup 
menekan 

Ctrl+w

Instalasi Driver Atheros AR5007 EG
Device Atheros AR5007 oleh Ubuntu terjadi kekeliruan dalam mengenali hardware dan terdeteksi sebagai : 
AR242x 802.11abg Wireless PCI Express Adapter. Langkah-langkahnya sebagai berikut :

1. Klik menu  System  → Administrasi  → Hardware Drivers, hilangkan tanda centang pada “Atheros 
Hardware Access Layer (HAL)”, lalu reboot.

2. Buka terminal melalui menu Applications  → Accesories  → Terminal. Ketik : 

$ wget http://snapshots.madwifi.org/madwifi-hal-0.10.5.6/madwifi-hal-0.10.5.6-
r3861-20080903.tar.gz.

3. Install paket berikut dengan perintah :

$ sudo apt-get install build-essential
4. Jalankan langkah-langkah dibawah ini :

$ tar -zxvf madwifi-hal-0.10.5.6-r3861-20080903.tar.gz
$ cd madwifi-hal-0.10.5.6-r3861-20080903/
$ make
$ sudo make install
$ sudo modprobe ath_pci

5. Setelah itu, edit file /etc/rc.local :

$ sudo gedit /etc/rc.local
6. Tambahkan di baris terakhir (sebelum baris "exit 0"), biar modul atheros bisa dijalankan tiap system 

dimulai : 

$ modprobe ath_pci
$ sudo reboot

7. Kalau lednya belum bisa nyala (seperti  di  Aspire 4520 dan saudaranya) bisa melakukan langkah 
seperti ini :

$ sudo gedit /etc/sysctl.conf
8. Tambahkan baris di bawah ini :

sysctl dev.wifi0.ledpin=3
sysctl dev.wifi0.softled=1

9. Restart dan lihat lednya.

Instalasi Driver MSI Wind rtl8187se WLan Card
Untuk anda yang mengalami masalah pada wireless untuk driver MSI Wind (RTL8187SE WLAN card) ,  
cukup mudah untuk kartu WiFi anda bisa dapat bekerja dengan baik. Ikuti langkah berikut ini :

1. Download paket dibawah ini berdasarkan distro Ubuntu yang anda miliki :



• linux-rtl8187se-modules-04coffee@2.6.24.19.21.deb (Hardy)

http://boskastrona.ovh.org/download/linux-rtl8187se-modules-
04coffee@2.6.24.19.21.deb

• linux-rtl8187se-modules-04coffee@2.6.27.7.11.deb (Intrepid)

http://boskastrona.ovh.org/download/linux-rtl8187se-modules-04coffee@2.6.27.7.11.deb
• linux-rtl8187se-modules-1023@2.6.27.7.11.deb (Intrepid)

http://boskastrona.ovh.org/download/linux-rtl8187se-modules-1023@2.6.27.7.11.deb
2. Untuk  instalasi  buka  konsole  terminal  dengan  klik  pada  Menu  Applications  → Accesories → 

Terminal, kemudian jalankan perintah di bawah ini :  

$ sudo dpkg -i linux-rtl8187se-modules-*.deb 

Tips dan Trik

Membuat Repository Lokal dari Repo DVD dan 
Hardisk
Repository adalah barang WAJIB pada ubuntu. Apabila tidak dapat mengakses repository, kita harus kerja 
ekstra apabila ingin menambahkan aplikasi baru, karena system library yang saling terkait (dependensi).  
Tentu akan merepotkan apabila mendownload satu persatu library yang dibutuhkan.

Masalahnya apabila pc anda susah terkoneksi dengan internet, tentu anda membutuhkan repository (bank 
aplikasi)  yang dapat disimpan didalam lokal  hardisk atau keping dvd. Selanjutnya kita  akan membahas 
langkah-langkah cara membuat repository offline dalam bentuk lokal hardisk dan keping dvd

➔ Repository local DVD

Setting Synaptic

Selanjutnya buka synaptic anda pada menu System  Administration  Synaptic <GAMBAR>→ →

Pada jendela synaptic buka menu edit  Add CDROM, masukkan DVD blank yang telah anda bakar→  
satu persatu <GAMBAR>

Langkah yang anda lakukan diatas bertujuan agar system mengindeks repository yang anda miliki,  
kelak apabila anda ingin menginstall paket aplikasi system dapat mengetahui paket tersebut disimpan 
pada dvd repo yang keberapa. 

Trik mount iso

Untuk  memount  iso  repository  ubuntu,  pastikan  anda  telah  mendownload  iso  nya  melalui 
ftp://repo.ugm.ac.id/iso/ubuntu-dvdrepo/intrepid/. pastikan juga anda telah membuat mount point untuk 
masing-masing dvd iso tersebut. Karena ada 5 iso, artinya anda harus menjalankan perintah mounting 
sebanyak 6 kali  :).  Sebagai contoh dibawah saya membuat folder sebagai tempat mount point di  
lokasi /media/repo/1 hingga 6.

Membuat folder 

$ sudo mkdir -p /media/repo/1
$ sudo mkdir -p /media/repo/2
$ sudo mkdir -p /media/repo/3
$ sudo mkdir -p /media/repo/4
$ sudo mkdir -p /media/repo/5
$ sudo mkdir -p /media/repo/6

ftp://repo.ugm.ac.id/iso/ubuntu-dvdrepo/intrepid/


Selanjutnya Mounting iso repository 

$ mount -o loop ubuntu-8.10-repository-i386-1r2_contrib.iso /media/repo/1
$ mount -o loop ubuntu-8.10-repository-i386-2_contrib.iso /media/repo/2
$ mount -o loop ubuntu-8.10-repository-i386-3_contrib.iso /media/repo/3
$ mount -o loop ubuntu-8.10-repository-i386-4_contrib.iso /media/repo/4
$ mount -o loop ubuntu-8.10-repository-i386-5_contrib.iso /media/repo/5
$ mount -o loop ubuntu-8.10-repository-i386-6_contrib.iso /media/repo/6

dengan  perintah  diatas,  isi  repository  iso  dapat  diakses  pada  folder  /media/repo/1  sampai 
/media/repo/5

Kemudian edit file /etc/apt/source.list dengan perintah 

$ sudo gedit /etc/apt/source.list

hapus dan ganti seluruh isinya menjadi seperti dibawah ini; 

deb file:/media/repo/1/ubuntu hardy main multiverse universe restricted
deb file:/media/repo/2/ubuntu hardy main multiverse universe restricted
deb file:/media/repo/3/ubuntu hardy main multiverse universe restricted
deb file:/media/repo/4/ubuntu hardy main multiverse universe restricted
deb file:/media/repo/5/ubuntu hardy main multiverse universe restricted
deb file:/media/repo/6/ubuntu hardy main multiverse universe restricted

yang perlu diingat adalah folder /media/repo/xx tidak baku, anda bisa mengganti  posisinya sesuai 
dengan keinginan

selanjutnya jalankan perintah; 

$ sudo apt-get update

Apabila  sampai  langkah  ini  tidak  menunjukkan  pesan  error,  artinya  anda  telah  berhasil  memiliki  
repository lokal. Selamat!

Cara kedua, menggunakan aufs

diambil dari http://ngoprek.fajran.web.id/2009/01/membuat-repositori-lokal-ubuntu-dari.html

Kita juga dapat menggabungkan 5 mount point repository tersebut seolah-olah menjadi satu folder.  
Jadi alamat repo yang di tulis di file /etc/apt/source.list cukup satu baris saja (tidak 5 baris)

Berikut kira-kira skemanya; 

/media/repo/1/  --+
/media/repo/2/    | 
/media/repo/3/    +-->  /media/ubuntu
/media/repo/4/    |
/media/repo/5/    |
/media/repo/6/  --+

Berikut langkah-langkahnya;

• Setelah  anda  memount  seluruh  iso  repositori,  buat  direktori  /media/ubuntu  dan  gabungkan 
seluruh mount point sebelumnya kedalam direktori /media/intrepid. Caranya dengan menjalankan 
perintah berikut

$ sudo mkdir -p /media/ubuntu
$ sudo mount -t aufs -o 
dirs=/media/repo/1:/media/repo/2:/media/repo/3:/media/repo/4:/media/repo/5:/media/repo/6 
none /media/ubuntu

http://ngoprek.fajran.web.id/2009/01/membuat-repositori-lokal-ubuntu-dari.html


• Kemudian satukan daftar  list  paket dari  ke 6 repository  tersebut dengan menggunakan skrip 
dibawah

#!/bin/sh
#by ngoprek.fajran.web.id
BASE=$1
DISTS=$2
SECTIONS=$3
ARCHS=$4
TARGET=$5

IFS_ORIG=$IFS
IFS=","

for dist in $DISTS
do
        for section in $SECTIONS
        do
                for arch in $ARCHS
                do
                        DIR=dists/$dist/$section/binary-$arch
                        URL=$BASE/$DIR/Packages.gz
                        TO=$TARGET/$DIR/Packages.gz

                        mkdir -p $TARGET/$DIR
                        wget -c -O $TO $URL
                done
        done

        wget -c -O $TARGET/dists/$dist/Release $BASE/dists/$dist/Release
        wget -c -O $TARGET/dists/$dist/Release.gpg $BASE/dists/$dist/Release.gpg
done

• Simpan skrip diatas, misal dengan nama file download.sh, kemudian jalankan perintah;

$ ./download-dists.sh \
    http://repo.ugm.ac.id/ubuntu/ \
    intrepid \
    main,restricted,universe,multiverse \
    i386 \
    /var/www/ubuntu/

• Terakhir masukkan alamat repository yang baru di file /etc/apt/source.list

deb file:/media/ubuntu/ intrepid main multiverse universe restricted

➔ Repository Local Hardisk
Selain menggunakan repository baik dalam bentuk DVD maupun iso, kita juga dapat memirror repository 
Ubuntu ke hardisk lokal. Keuntungannya kita dapat memiliki repository yang selalu update, namun kita harus 
menyediakan space sekitar 25G+ untuk menyimpan mirror repository tersebut.

Untuk  memirror  repository  Ubuntu  Intrepid  Ibex  jalankan  perintah  dibawah;  Buatlah  direktori  untuk 
menyimpan repository tersebut, misal di /media/ubuntu 

$ sudo mkdir /media/ubuntu

selanjutnya jalankan perintah debmirror seperti dibawah ini 

$ debmirror --progress -m --host=repo.ugm.ac.id --root=ubuntu --method=ftp \
--dist=intrepid,intrepid-updates,intrepid-security,intrepid-backports \
--section=main,multiverse,universe,restricted \
--arch=i386 --nosource --ignore-release-gpg --ignore-missing-release --passive \



media/ubuntu/

Perintah  diatas  artinya  pada  baris  pertama  menunjukkan  alamat  server  yang  akan  kita  mirror 
(repo.ugm.ac.id) dengan menggunakan protokol ftp. Perintah pada baris kedua menunjukkan distribusi yang 
akan kita mirror, pada baris ketiga adalah bagian-bagian yang akan kita mirror. Baris keempat arsitektur  
yang akan kita mirror (i386), terakhir adalah lokasi direktori tempat menyimpan mirror.

Selain cara diatas, anda juga bisa membuat skrip sederhana, berikut langkah-langkahnya;

• Buka terminal kemudian ketikkan vim script untuk membuat script download

• kemudian  ketikkan  baris  program seperti  dibawah lalu  simpan,  sebagai  contoh  kita  beri  namanya 
script-repo

#!/bin/sh 
host=repo.ugm.ac.id 
root=ubuntu 
#host=kambing.ui.edu 
#root=ubuntu 
dist=intrepid,intrepid-updates,intrepid-security 
section=main,multiverse,universe,restricted 
arch=i386 
dir=/media/ubuntu 
debmirror --progress -m --host=$host --root=$root --method=http --dist=$dist 
--section=$section --arch=$arch --nosource /media/disk-2/repo/ubuntu/ --ignore-release-
gpg --postcleanup 

• Selanjutnya berikan hak akses executable pada file script-repo tersebut.

$ chmod +x script-repo

• Jalankan script-repo tersebut pada target partisi yang kita inginkan untuk menyimpan repository.

$ sh script-repo

• Tunggu sampai selesai, selamat anda telah memiliki lokal repository offline

Download Paket via Web
Aplikasi  ini  sengaja  dibuat  oleh  mas  fajran  [http://fajran.web.id/] dari  Universitas  Indonesia,  untuk 
memberikan kemudahan kepada pengguna ubuntu yang tidak memiliki koneksi internet. Dengan aplikasi ini,  
anda dapat medownload aplikasi dengan ketergantungan library-nya juga. Misalkan anda mencari aplikasi 
audacious  pada  Ubuntu  8.10  Intrepid  Ibex,  maka  anda  cukup  menyesuaikan  base  distribution dan 
memasukkan nama aplikasi yang anda cari.

Hasilnya ? anda akan mendapatkan nama-nama aplikasi dan library yang perlu anda download. Selanjutnya, 
aplikasi dan library yang telah anda download, dapat di install satu per satu ke dalam sistem anda.



Upgrade ke Open Office 3.0
Ubuntu biasanya tidak menyediakan update untuk paket aplikasi open office-nya, dan paket aplikasi lain 
yang menjadi default pada versi tertentu. Karena paket Open Office ini tidak terupdate, sehingga anda perlu  
melakukan update sendiri. Berikut ini merupakan instalasi Open Office pada distro berbasis Debian: 

➔ Cara yang pertama

Download Aplikasi

1. Web  Official  download  OpenOffice.org  bisa  di  unduh  disini 
http://download.openoffice.org/other.html;

2. Bisa  juga  download  disini  http://repo.ugm.ac.id/ekstra/office/openoffice/3.0.0 kemudian  pilih 
versi Linux DEB;

3. Untuk versi DEB, silahkan download disini OOo_3.0.0_LinuxIntel_install_en-US_deb.tar.gz.

Uninstall Open Office versi lama

1. Jalankan  aplikasi  Synaptic  Package  Manager dengan  meng-klik  menu  System → 
Administration  → Synaptic Package Manager;

2. Kemudian hapuslah paket aplikasi openoffice.org-core, dan openoffice.org dengan mengklik 
kanan dan pilih menu Mark for Complete Removal. 

Instalasi

1. Buka terminal dengan meng-klik menu  → Application  → Accessories  → Terminal dan ketik 
perintah berikut:

$ tar -xzvf OOo_3.0.0_LinuxIntel_install_en-US_deb.tar.gz 
2. Install Aplikasi melalui paket DEB 

$ cd OOO300_m9_native_packed-1_en-US.9358/DEBS/
$ sudo dpkg -i *.deb

3. Memperbarui menu Gnome dengan masuk ke dalam subdirectory desktop integrasi; 
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$ cd desktop-integration/ 
4. Jalankan lagi perintah instalasi sebelumnya; 

$ sudo dpkg -i *.deb 
5. Setelah ini, Open Office akan terdapat pada menu gnome anda. Cek di menu Application → 

Office  → OpenOffice.org.

➔ Cara yang kedua
Cara yang kedua ini hanya di rekomendasikan bagi pengguna Ubuntu versi 8.04 Hardy Heron, dan 8.10 
Intrepid Ibex, karena repo yang disediakan hanya untuk kedua versi Ubuntu tersebut. langkah-langkahnya : 

1. Edit file source.list dengan menggunakan perintah;

$ sudo gedit /etc/apt/source.list
2. Kemudian tambahkan alamat repository openoffice 3.0 ubuntu pada baris paling bawah seperti contoh 

berikut;

deb ftp://repo.ugm.ac.id/ekstra/office/openoffice-pkgs/ hardy main multiverse universe 
restricted
untuk Ubuntu 8.04 Hardy Heron seperti berikut :

deb ftp://repo.ugm.ac.id/ekstra/office/openoffice-pkgs/ intrepid main multiverse 
universe restricted

3. Setelah menambahkan repository openoffice, lakukan update paket dengan cara :

$ sudo apt-get update
4. Kemudian lakukan langkah upgrade dengan mengetikkan perintah berikut :

$ sudo apt-get install openoffice.org openoffice.org-gnome openoffice.org-style-crystal
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➔ Mencari list repository
Repo  UGM  menyediakan  fasilitas  sources.list  generator  ubuntu,  yang  dapat  memberikan  kemudahan 
kepada  pengguna,  ketika  bingung  mencari  sources.list  untuk  repository  (gudang  aplikasi).  Aplikasi  ini  
dikembangkan oleh  fajran [http://fajran.web.id/] dari  Universitas Indonesia.  Untuk menggunakannya, ikuti 
langkah berikut :

1. buka browser anda, dan ketik alamat berikut http://repo.ugm.ac.id/mulai.html

2. kemudian langsung menuju ke bagian Ubuntu.

• Selanjutnya klik tombol buat isi sources.list, dan anda akan mendapatkan susunan sources.list.

Keterangan :

Rilis : pilihan untuk memilih rilis ubuntu yang terbaru

Komponen : pilihan ini secara default dan terdiri dari

• Main - Perangkat lunak bebas dan didukung oleh Ubuntu

• Restricted - Perangkat lunak tidak bebas namun didukung oleh Ubuntu

• Universe - Perangkat lunak bebas dengan dukungan dari komunitas

• Multiverse - Perangkat lunak bebas dengan dukungan dari komunitas

Repositori kode sumber : pilihan repositori ubuntu yang berisi sources (berikut kode-nya)

Repositori tambahan : tambahan update aplikasi dan security 
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• Updates - Berisi paket-paket perbaikan yang direkomendasikan

• Security - Berisi paket-paket perbaikan yang bersifat sangat penting

Cermin repositori : pilihan untuk memilih repositori (mis : repo.ugm.ac.id ato kambing.ui.edu), jika anda 
memilih lainnya, maka anda harus memasukkan url dari cermin repositori tersebut. 
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